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   人身事故および死亡事故防止の為の警告   

 警警  告告－－ママニニュュアアルルのの指指示示をを厳厳守守すするる事事  
 この装置の設置、運転もしくは保守を行う場合には、事前にこの操作説明書とその他の関連する印刷物を

よく読んでおく事。プラントの運転方法、その安全に関する指示、および注意事項についてよく理解してお
かなければならない。もしこのような指示に従わない場合には、人身事故もしくは物損事故が発生する事
もあり得る。 
 

 警警  告告－－ママニニュュアアルルのの改改訂訂版版にに注注意意すするる事事  
 この説明書が発行された後で、この説明書に対する変更や改訂が行われた可能性があるので、読んで

いる説明書が最新であるかどうかを弊社のウェブサイトwww.woodward.com/pubs/current.pdfでチェ
ックする事。各マニュアルのマニュアル番号の末尾に、そのマニュアルの最新のレビジョン・レベルが記
載されている。また、www.woodward.com/publicationsに入れば、ほとんどのマニュアルをPDF形式
で入手する事が可能である。もし、そのウェブサイトに存在しない場合は、最寄の弊社の支社、または代
理店に問い合わせる事。 
 

 警警  告告－－オオーーババススピピーードドにに対対すするる保保護護  
 エンジンやタービン等の様な原動機には、その原動機が暴走したり、その原動機に対して損傷を与えた

り、またその結果、人身事故や死亡事故が発生する事を防止する為に、オーバスピード・シャットダウン
装置を必ず取り付ける事。 
このオーバスピード・シャットダウン装置は、原動機制御システムからは完全に独立して動作するもので
なければならない。安全対策上必要であれば、オーバテンペレイチャ・シャットダウン装置や、オーバプ
レッシャ・シャットダウン装置も取り付ける事。 
 

   警警  告告－－装装置置はは適適正正にに使使用用すするる事事  
 本製品の機械的、及び電気的仕様、または指定された運転条件の限度を越えて、許可無く本製品の改造、

または運転を行った場合、人身事故並びに、本製品の破損も含む物損事故が発生する可能性がある。そ
のような無許可の改造は、(i)「製品およびサービスに対する保証」に明記された「間違った使用方法」や
「不注意」に該当するので、その結果発生した損害は保証の対象外となり、(ii)製品に関する認証や規格へ
の登録は無効になる。 

 
   物的損害および装置の損傷に対する警告   
   注注  意意  
 この装置にバッテリをつないで使用しており、そのバッテリがオルタネータまたはバッテリ充電装置によ

って充電されている場合、バッテリを装置から取り外す前に必ずバッテリを充電している装置の電源を切
っておく事。そうしなければ、この装置が破損する事がある。 
電子制御装置の本体およびそのプリント基板を構成している各部品は静電気に敏感である。これらの部
品を静電気による損傷から守るには、次の対策が必要である。 

 • 装置を取り扱う前に人体の静電気を放電する。（取り扱っている時は、装置の電源を切り、装置をアー
スした作業台の上にのせておく事。） 

 • プリント基板をプラスティック、ビニール、発泡スチロールに近付けない事。（ただし、静電気防止対策
静電破壊防止対策が行われているものは除きます。） 

 • 手や導電性の工具でプリント基板の上の部品や導通部分（プリント・パターンやコネクタ・ピン）に触ら
ない。 

 
   警告／注意／注の区別    
警警告告：： 取り扱いを誤った場合に、死亡または重傷を負う危険な状態が生じることが想定される場合 

注注意意：： 取り扱いを誤った場合に、軽傷を負うかまたは物的損害のみが発生する危険な状態が生じるこ
とが想定される場合 

注注：： 警告又は注意のカテゴリーに記された状態にはならないが、知っていると便利な情報 
 

 改訂されたテキスト部分には、その外側に黒線が引かれ、改訂部分であることを示します。 
 

この出版物の改訂の権利はいかなる場合にもウッドワードガバナー社が所有しています。ウッドワードガバナー社からの 
情報は正確かつ信頼できるものでありますが、特別に保証したものを除いてその使用に対しては責任を負い兼ねます。 
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第 １ 章 
ソフトウエア・ツール 

 
 

NT RTOS のソフトウエア・ツール 
 
このマニュアルでは、AtlasPC™制御装置に対して、離れた場所から設定値を入力・変更したり、データの送受信を行う為に

弊社が開発した、Windows NTのRTOS（リアル・タイム・オペレーティング・システム）上で動作するソフトウエア・ツールに付

いて解説しています。 
 
AtlasPC 制御装置は、外部とのデータのやり取りや、保守点検や、トラブルシューティングを全て、シリアル通信ポートやイー

サネット・ポートから行えるように設計しています。AtlasPCに直接接続されるキーボードやCRTモニタやマウスなどはありま

せんので、このようなソフトウエア・ツールを使用すれば、外部からの操作を受付けない完全自動運転（headless operation）

を行う事ができます。（ただし、AtlasPC は、one-board-computer ですから、キーボードや CRT モニタやマウスなどのデス

ク・トップ・コンピュータに必要な I/O を制御する機能自体は持っています。） 
 

   注注注：：：   
 このマニュアルに掲載した画面の絵と、使用しているソフトウエア・ツールの画面の絵は若干異なる場

合がありますが、それは、使用しているソフトウエア・ツールのレビジョン番号が新しくなっている為で

す。 
 
現在、弊社が出荷しているAtlasPC制御装置の IPアドレスは、スタティック IPアドレスになっています。

イーサネット上での IP アドレスの衝突を避ける為に、このマニュアルを良く読んでから AtlasPC のイー

サネット・ポートをネットワークに接続してください。 
 

ツールの概要 
 
プログラミング・ツールは、アプリケーション・プログラム作成用のツールです。 
アプリケーション・プログラムを作成するには、GAP™（Graphical Application Program）や Ladder Logic を使用します。

GAP による出力は、Coder プログラム走行時に、コンパイラとアセンブラとリンカにより実行可能ファイルに変換されて、その

後で、ターゲット・マシンである Atlas 制御装置に転送（Load）されます。この転送されるアプリケーション・プログラムは、弊社

の NetSim™シミュレーション・ツールを使ってテストする事ができます。 
 
使用している制御装置に、（PC/104 DeviceNet や CANOpen や Profibus などの）フィールドバス・ボードが装着されている

場合、添付の CD-ROM に収録されている ApplicomIO を使用して、このボードと、関連するネットワーク・モジュールの為の

コンフィギュレーション・ファイルを作成する事ができます。 
 
サービス・ツールは、オペレータがファイルを転送したり、アプリケーション・プログラムの始動／停止を行ったり、コンフィギュ

レーション・データの設定を行ったり、ハードウエアやソフトウエアのトラブルシュートを行ったり、制御装置のステイタスを見た

り、このサービス・ツールの監視下にある原動機システムの運転を行う為に使用します。 
 
 
   注注注   意意意   
 このソフトウエア・ツールの操作を誤った場合、原動機が危険な状態になる事もあり得ます。然るべきト

レーニングを受けたオペレータ以外、このソフトウエアを使用できないようにしておいてください。 
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図1-1． ソフトウエア・インタフェース・ツールの概要 
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プログラマ用ツール 

 
アプリケーション・プログラムを新規に作成する時や、既存のアプリケーション・プログラムを修正する時には、以下のツールを

使用してください。 
 
弊社の GAP 

 GAP を使用すると、ユーザは、このソフトウエアに組み込まれた描画ソフトを使用して、原動機システムの制御ロジック

を描く事ができます。このソフトウエアは、Windows®環境で動作する PC（パーソナル・コンピュータ）上で実行する事ができ

ます。描画ソフトで制御ロジックを作成し終わったなら、GAP は、このアプリケーション・プログラムの完全性チェックを行い、

それから Coder に読み込ませる為の”.CDR”ファイルを作成します。 
 
GAP モニタ 
このデバッグ・ツールを使用すると、アプリケーション・プログラム実行中に GAP ブロックの状態を見たり、変更可能な設定値

の調整を行ったり、GAP ブロックの入出力値が変化するのをチェックしたり、アプリケーション・プログラムを書き換えたりする

事ができます。このソフトウエアは、内蔵の Watch Window II ツールを使用して Atlasのイーサネット・ポートとデータのやり

取りを行う事ができます。 
 
弊社の Coder 

 Coderは、GAPで作成したアプリケーション・プログラムに異常がないかどうかチェックする為のソフトウエアです。異常

がなければ、Coderは、自動的にコンパイラとアセンブラとリンカを呼び出して、実行可能ファイル（原動機制御プログラム）とリ

アル・タイム・エクステンション・ファイルを作成します。このふたつのファイルは AppManager を使用して（AtlasPC などの）

ハードウエアに転送されます。プログラムが Coder を通る時に異常が発見されると、エラー・ファイルが作成されますので、こ

のエラー・ファイルを参照して、プログラムの修正を行ってください。 
 
 
 注注注：：：   
 使用しているパーソナル・コンピュータに Microsoft 社の VisualC++をインストールしていなければ、

GAP のアプリケーション・プログラムの実行可能ファイルを作成する事はできません。 
 
ApplicomIO® Console 
ApplicomIO Console は、基板の定義を行ったり、フィールド・バスに接続されるネットワークや装置の動作モードの設定を行

う為に使用する、設定用コンソール（端末）です。このコンソールは、Windows NT4.0 または Windows 2000 を搭載した PC
上で走る、Windows ソフトウエアです。 
 
NetSim 
NetSim は、原動機制御用ソフトウエアをテストする為に弊社が開発した、Windows NT 上で動作するシミュレータ・ソフトウ

エアです。このソフトウエアをモデリング・パッケージに接続するとクローズド・ループのシミュレーション環境を組む事ができ

ます。このソフトウエアをスタンド・アロン・モードで走らせると、オープン・ループのテストを行う事ができます。ACSL ベース

の Matlab/Simulink や Matrix X/Systembuild モデリング・パッケージに接続する事もできます。 
 
NetSim Control Executive 
このプログラムは、弊社の原動機制御システムによって制御される装置の運転時のシミュレーションを行うプログラムに対する、

インタフェースとして動作します。現在、OPC（プロセス制御用の OLE 通信プロトコル）をサポートしています。 
 
 
 
 
訳注： ACSL：Advanced Continuous Simulation Languageは、連続型のシミュレーションを行うモデル記述言語です。ACSLを利用することに

より物理現象、社会現象、制御系など、あらゆる時間依存現象のシステムを簡単にモデル化し、対話形式でシミュレーションするこ

とができます。 

OLE：Object Linking and Embeddingとは他のアプリケーション・ソフトウエアで作成したデータをオブジェクトとして別のプログラム

（MSExcelや MSWordなど）に埋め込んで表示する事です。 
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BootP 
BootP は、（例えば図2-1 の制御装置の専用ネットワークのような）イーサネット上の分散I/O で動作する弊社のソフトウエア・

ツールです。これは、IP/UDP（Intetnet Protocol/ User Datagram Protocol）の中のブートストラップ・プロトコルであり、ネッ

トワークに接続された装置（クライアント・マシン）は、これを使用して自分自身の IP アドレス（インターネット上のアドレス）を見

つけます。このプロトコルはサーバ（Server）として動作し、常にリクエストが来るのを待っています。このサーバがリクエストを

受け取ると、サーバは、そのリクエストのMACアドレス（イーサネット上の、その機械に対するハードウエア固有のアドレス）に

一致するエントリを BootP データベース内で探します。もし一致するエントリがあれば、サーバは、一致したエントリの IP アド

レスを付けて、そのメッセージに対する応答を返します。 
 

ユーザ用ツール 
 
以下のツールは、ファイルを転送したり、アプリケーション・プログラムの始動／停止を行ったり、コンフィギュレーション・デー

タの設定を行ったり、ハードウエアやソフトウエアのトラブルシュートを行ったり、制御装置のステイタスを見たり、このサービ

ス・ツールの監視下にある原動機システムの運転を行う為に使用します。 
 
アプリケーション・マネジャ（AppManager） 

 AppManager は、弊社の製品に組み込まれた NT CPU モジュールと通信する為に使用する、（パーソナル・コンピュ

ータの）Windows 上で動作するリモート・アクセス・ツールです。AppManager を使用すると、機側もしくは離れた場所から、

アプリケーション・ソフトウエアの転送、回収、起動、停止、再起動を行う事ができます。AtlasPC には、AppManager と通信

する事ができる AMService.exe というプログラムが組み込まれています。AppManager を使用すると、AtlasPC のイーサネ

ット用ネットワーク・アドレスを変更したり、ログ・ファイルを回収したりする事もできます。 
 
 

   注注注：：：   
 AppManagerは、Windows NTやWindows 2000などのWindows NTオペレーティング・システム

上でのみ動作します。Windows 95 を搭載した PC では、動作しません。 
 
MicroPanel 

 MicroPanelは、弊社のNT CPUモジュールを搭載した制御装置に接続して使用する、表示画面20行のサービス・ツ

ールです。これを使用すると、DEBUG モードや SYSTEM INFORMATION モードや FAULTS モードや SERVICE モ

ードや CONFIGURE モードに入る事ができます。上記の各モードには、MicroPanel と NT CPU モジュールが Windows 
NT ネットワークで接続されていれば、機側でも離れた場所からでも入る事ができます。MicroPanel を Watch Window と比

較すると、多少の機能上の制限があります。 
 

エンジニアリング・ツール 
 
以下のツールは、制御システムのデバッグ、パラメータの監視、設定値の再調整、リアル・タイムのデータ収集、データ解析、

遠隔制御に使用します。詳細は、弊社のセール・エンジニアにお問い合わせください。 
 
Microsoft NetMeeting 

 Microsoft 社の NetMeeting を使用すると、制御装置を遠隔操作したり、弊社の制御装置の Windows NT デスクトップ

画面にアクセスしたりする事ができます。弊社の制御システムには、このユーテリティ・ソフトウエアと通信する機能が組み込ま

れており、（弊社の Atlas 制御装置の Windows NT デスクトップの）CRT 画面やキーボードやマウスの動作を（他のコンピュ

ータで）模擬的に行う事ができます。このユーテリティ・ソフトウエアは、イーサネットのTCP/IPでも、モデム接続でも使用する

事ができます。 
 



マニュアル JA26103 NT RTOS ソフトウエア・ツール 

 Woodward 5

 
コントロール・アシスタント 

 コントロール・アシスタントは、Windows 95やWindows 98やWindows NTを搭載した32ビット・コンピュータ上で動

作するカスタム・メイドのアプリケーション・ソフトウエアです。このユーテリティ・ソフトウエアは、シリアル通信やイーサネットで

制御装置と通信しながら、以下の仕事を行います。 
• Tunable Maintenance  調整可能な設定値の取得、分類、GAP で設定した上下限値との比較、格納、変更した調整

可能な設定値の制御装置への転送（upload）を行います。 
• Datalog Plotting  データ・ログ情報を高速で受信して印刷します。 
 
ServLink Server 

 ServLink サーバは、弊社の Servlink プロトコルを使用して制御装置と通信する為に設計された DDE（Dynamic 
Data Exchange）サーバです。Servlink プロトコルを使用すると、ServLink サーバで DDE クライアント（MSWindows の

DDE 機能を使ってデータの読み書きをしようとする他のプログラム）が指定した制御装置内部のパラメータを読んだり、変更

したりする事ができます。Visual BasicやExcelやWatch WindowのようなDDEクライアントは、制御装置内部の変更可能

なパラメータを、監視したり、PC に取り込んだり、変更したりする事ができます。 
 
Watch Window II 

 Watch Window II は、イーサネットで接続された（例えば AtlasPC のような）弊社の ServLink サーバと通信を行い、

全ての制御システムのデータを表示したり操作したりする為のOPCクライアント（データ受け取り側装置）です。このインタフェ

ースを使用すると、制御装置内部の選択したパラメータを、操作したり、監視したりする事ができます。Watch Window には、

以下のような機能があります。 
• ServLink で指定された OPC データ・サーバによる制御パラメータの読み書き 
• 他の装置からの設定値の読み込み（Load）と、他の装置への書き込み（Save） 
• データの階層木の閲覧 
• 変数（パラメータ）の解説 
• Watch Window II による複数のデータ・シート 
• 複数の Watch Window II の閲覧 
• Windows 画面においてマウスを使用してドラッグ・アンド・ドロップ操作を行う事ができる 
• 変更可能な設定値の値の変更 
• EEPROM へ格納するデータの更新 
 
Watch Window Standard 

Watch Window Standard は、GAP で設定した制御装置のシリアル通信ポートを使ってデータのやり取りを行います。

これは、制御システムの調整を行う為に必要な最少限の機能を装備した、装置開発用兼トラブル解析用の、無料のツールで

す。 
 
Watch Window Professional 

 Watch Window Professional も、制御システムの調整を行う為に使用する、装置開発用兼トラブル解析用のツールで

す。このツールは、Watch Window Standard の全機能とアプリケーション・プログラムのロード機能やデバッグ用パラメータ

の目視などの高度な機能を備えた、Watch Window II に近いソフトウエアです。Watch Window Professional も、GAP で

設定した制御装置のシリアル通信ポートを使って、データのやり取りを行います。 
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Ladder Logic 

 弊社のLadder Logicプログラムは、GAPに添付して出荷されます。カスタマは、Ladder Logicを使用して制御装置の

プログラムを作成したり、運転状態のモニタリングを行う事ができます。ラダー・ロジックの基本的な構成を理解しているエンジ

ニアあれば、弊社の Ladder Logic を使用してプログラムを作成する事は簡単な事です。このプログラムの各コマンドを起動

するには、マウスのカーソルをコマンドのアイコンに持って行き、そこでマウスをクリックします。 
 
Ladder Logicプログラムは、シリアル通信かイーサネットで弊社のデジタル制御装置に接続された PC 上で動作します。この

プログラムを走らせるには、Windows の動作環境が必要です。Ladder Logic プログラムは、PC が制御装置と接続されてお

り、制御装置が運転中の原動機を制御している時のみ、PC 上で作成したり変更したりする事ができます。プログラムに行う変

更は、変更したプログラムを制御装置に転送して、初めて有効になります。 
 
 
 注注注：：：   
  AtlasPC 制御装置では、バージョン 1.05 以上の Ladder Logic プログラムしか使用できません。 
 
Service Packs 
Footprint release（ソフトウエアの基本的な部分に対する改訂）を行う合間に、小幅な改良が、弊社のソフトウエアに行われる

事がありますが、AppManager を使用して最新のソフトウエアを AtlasPC にダウンロードする事ができます。 
 
ソフトウエア・ツールの取得 
 
弊社のソフトウエア・ユーテリティには、使い易さを考えて、制御装置に内蔵されているものもあります。このようなソフトウエア

は、Atlas の C:\Woodward のディレクトリに置かれているはずですが、Windows の NT Explorer を使用して、設定用PC
の方にも引っ張って来る事ができます。第２章の「制御装置からツールを取り出す」の項を参照してください。 
 
ユーテリティ・ソフトウエア ファイル名 操作内容 
Application Manager AppManager.exe アプリケーション・プログラムの起動と停止、プログラムの転送と

回収をネットワークを通じて行う 
MicroPanel MicroPanel.exe 制御装置の設定値の目視・確認と変更をネットワークを通じて行う 
Microsoft NetMeeting nm30.exe 制御装置のオペレーティング・システムを遠隔操作したり、離れた

場所から設定値を変更したりする 
 
弊社のウエブ・サイトから、以下のようなソフトウエア・ツールをダウンロードする事ができます。サイト名は、次のとおりです。 
  www.woodward.com/ic/software 
 
• AppManager 
• AMService （制御装置に常駐する AppManager ファイル） 
• Watch Window / ServLink 
• MicroPanel 
• NetSim 
• Woodward Coder 
• Woodward GAP / Ladder Logic 
• Woodward Control Service Packs 
• GAP Monitor 
 
 
 
 
 
 
 
 
訳注： Footprintとは、Atlas制御装置のコンパクト・フラッシュ・ディスクに搭載されたオペレーティング・システム（OS）であり、アプリケーシ

ョン・ソフトウエアの更新は、Service Packを使用して、この OS に対して行います。 



マニュアル JA26103 NT RTOS ソフトウエア・ツール 

 Woodward 7

 
Microsoft NetMeeting 
このプログラムは、制御装置のデスクトップ画面にアクセスする為に使用します。このプログラムは、以下のサイトにあります。

必要であればダウン・ロードしてください。 
• AtlasPC のハード・ドライブ上の C:\Woodward のディレクトリ （Explorer を使って引っ張って来る事ができます。） 
• Microsoft 社のウエブサイト（www.microsoft.com/netmeeting） 
• ご使用になっておられる PC の OS が Windows NT か Windows 2000 であれば、その中に nm30.exe というソフトウ

エアがあるはずです。nm30.exe を走らせてください。 
 
Control Assistant 
• このソフトウエアは、「オンライン・ライセンス契約」の対象外の製品です。弊社、または代理店から、フロッピィ・ディスクと

してお買い上げ頂く事になります。部品番号8928-101 で、ご注文ください。 
 
Microsoft VisualC++ 
このソフトウエアは、弊社のCoderがGAPで作成したプログラムを、CPUが実行する実行コードに変換する時に呼び出しま

す。このソフトウエアは、以下のウエブサイトからダウンロードする事ができます。 
• Microsoft 社のウエブサイト（http://msdn.microsoft.com/visualc/） 
 
ApplicomIO CD-ROM 
この CD-ROM は、Profibus や CANOpen や DeviceNet などの Fieldbus ネットワークの動作条件の設定を行う為に使用し

ます。この CD-ROM は、Fieldbus ボードを装着した AtlasPC に添付して出荷されます。 
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第 ２ 章 
イーサネットのネットワーク 

 
 
 注注注：：：   
 現在、AtlasPC は以下のスタティック IP アドレスで出荷されます。 

Ethernet #1 = 190.14.99.220 (CPU) 
Ethernet #2（オプション） = 192.168.10.20 (PC/104) 
Subnet Mask: 255.255.0.0 
Default Gateway: none 

 
上記のネットワークの設定は、AtlasPCをお客様の制御システムに組み込む時には当然変更されるはずですが、この時、「ネ

ットワークに関する基礎知識」を理解しておかなければなりません。お客様の制御システムを管理しているネットワーク・システ

ム管理者に相談するか、このマニュアルの第7 章の「インターネットとイーサネットについて」の所を読んでください。また、ご

使用になっておられるパーソナル・コンピュータで Start → Setting → Control Panel とクリックしていき、ここでヘルプをクリ

ックして「ネットワークとダイアル・アップ接続」を選択すれば、ネットワークに関する詳しい解説を読む事ができます。 
 

概 要 
 
Atlasには、シールド付きの10/100 Base-TX RJ45のメスのコネクタが 2個付いており、これでTCP/IPによる通信を行いま

す。この 2 個の通信ポートは、ネットワーク・ファイルの共同使用やアプリケーション・プログラムの管理や遠隔操作や、その他、

イーサネット上の Modbus®が行う様々な制御機能を行う為に使用します。弊社の Atlas 制御装置とネットワークを組む場合に

は、Windows NT オペレーティング・システムが走るクライアント・コンピュータが 1 台必要になります。 
• IPアドレスの衝突を避ける為に、1本のネットワークに接続されている全ての装置（コンピュータ）に対して、異なるイー

サネット IP アドレスを指定しなければなりません。 
• ネットワークでDHCPサーバやAppManagerやNetMeetingを使用する場合、AtlasPC制御装置のコンピュータ

名は、その機械の IP アドレスに対応します。 
 
 
 注注注：：：   
 デュアル・イーサネットの AtlasPC の場合 ・・・ このマニュアルに記載したソフトウエア・ツールを使用

できるように、最初は、1 個のポートをローカル PC ネットワークと同じネットワークに接続するように設

定しておいてください。図2-1 は、AtlasPC をふたつのネットワークに接続した場合を、図示したもので

す。 
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図2-1． AtlasPCをデュアル・イーサネットに接続する場合 

 
最初のセットアップ手順 

 
ここでは、Atlasのイーサネット・ポートを安全に接続する方法、Atlasのイーサネット・ポートとAtlasが接続されるネットワーク

の互換性をチェックする方法、ローカル PC ネットワークから Atlas に接続して、ソフトウエア・ツールを Atlas 設定用のコンピ

ュータにコピーする方法に付いて説明します。ここでは、図2-1 に示されている Computer Name が NTA07887 と言う

AtlasPC を例として取り上げます。デフォルトの IP アドレスは、図2-1 に示す値に変更されていると考えてください。 
 
ステップ１： 
1. AtlasPC 制御装置のコンピュータ名（Compter Name）を記載したラベルは、筐体の上面のカバーに貼られています。

このコンピュータ名は、Windows NT を搭載した AtlasPC 毎に違っています。コンピュータ名は、アルファベットの

NTA と、その後の 5 桁の数字からなっています。コンピュータ名を下の欄に記録しておいてください。 
 
 注注注：：：   
 このマニュアルの裏表紙の裏側に、ソフトウエアのセットアップ情報を記録する欄がありますので、ここ

に必要な情報を記録しておくと、将来役に立ちます。 
 
 NTA ______________________________  
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2. 工場出荷時設定の AtlasPC の IP アドレス、サブネット・マスク、デフォルトのゲイトウエイは、これから接続するネットワ

ークと互換性があるかどうか、ネットワーク管理者に聞いてください。 
 
 注注注：：：   
 ご使用になっておられる PC でネットワークの設定がされているかどうかは、DOS コマンド画面を開い

て”ipconfig”と入力すれば、見る事ができます。 
 
 されている＝YES されていない＝NO 
 
3. YES であれば、STEP2 に行きます。 

NO であれば、ネットワークに接続するには、どのように設定すれば良いか調べてください。 
 
 イーサネット＃１： 
 モード： スタティック IP または DHCP 
 IP Address：  _________________________  
 Subnet Mask：  _________________________  
 Default Gateway：  _________________________  
 
 イーサネット＃2： 
 モード： スタティック IP または DHCP 
 IP Address：  _________________________  
 Subnet Mask：  _________________________  
 Default Gateway：  _________________________  
 
ここで、ステップ 2 を飛ばして、ステップ 3 に行きます。 
 
ステップ２： 
1. AtlasPC が接続されるネットワークに、工場出荷時に AtlasPC に設定したアドレスと同じ IP アドレスが設定されている

機械があるかどうか、調べてください。この章の「ネットワークのピンギング」の所を参照してください。 
 
 同じ機械がある＝YES 同じ機械はない＝NO 
 
2. YES であるか、ネットワークの設定を変更する必要がある場合、ステップ 3 に行きます。NO であれば、そのまま

AtlasPC をネットワークに接続する事ができますから、ステップ 6 の「制御装置からツールを取り出す」に行きます。 
 
ステップ３： 
イーサネット・ポートに接続する 
 
AtlasPCとローカル・ネットワークで接続されたPCが通信できるようにする為には、Atlasのイーサネット IPアドレスを変更し

なければなりませんが、その為には、弊社のソフトウエア・ツール AppManager が必要です。このソフトウエア・ツールは、弊

社のウエブサイトからダウンロードする事ができます。第１章の、「ソフトウエア・ツールの取得」の所を参照してください。 
 
ネットワーク上でのIPアドレスの衝突を避ける為に、AtlasPC制御装置と、これをセットアップする為に使用する設定用PCを

ネットワークから外します。そして、この 2 台の装置を直結します。直結の仕方に付いては、図2-2 の参考例を参照してくださ

い。 
 
1. PC 側で、ネットワーク・アプリケーションをシャットダウンしてください。しかし、ログ・オフはしないでください。 
 
2. 図2-2 で示すように接続して、AtlasPC に電源を投入してください。 
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 注注注   意意意   
 AtlasPC をローカル接続される PC に接続する時に、シールドの付いていないイーサネット・ケーブル

を使用すると、Atlas のイーサネット・ポートが静電破壊により壊れる事があると言う事がわかっていま

す。接続には、必ずシールド付きのケーブルを使用してください。 
 

 
図2-2． ネットワーク・ケーブルの接続例 

 
• デュアル・イーサネット構成のAtlasPCでは、どちらのポートを相手側のPCとの接続に使用しても構いませんが、イー

サネット・ポート＃１と＃２を、ハブまたはスイッチを使用して両方同時に接続するのが、最も良い方法です。何故なら、

AtlasPC には、イーサネット・ポート＃１と＃２が同じドメイン（LAN）に接続されているとわかっているので、どちらか一

方のポートのメッセージにしか応答しないからです。 
 
• この制御装置のイーサネット・ポート＃１と相手側の PC とが正しく接続されたなら、AtlasPC のイーサネット・ボードと相

手側PC の緑色の Link の LED が両方共点灯します。 
 
 注注注：：：   
 PCにハブやスイッチを接続すると、PC側のLinkのLEDは、Atlas制御装置が接続されていなくても点

灯します。AtlasPCのイーサネット・ポート#2には、2個の LEDが付いていますが、これは装置上面の

カバーのマイクロプロセッサ・ファン・スロットを通して見る事ができます。上面のカバーの中ほどを覗け

ば、見る事ができます。 
 
これで、Atlasの IPアドレスの設定を変更する準備ができました。新しいスタティック IPが必要であれば、ステップ４へ行きま

す。DHCP 指定アドレスが必要であれば、ステップ５に行きます。（DHCP に付いては、インターネット関連用語参照の事、） 
 
 
 注注注：：：   
 アプリケーション・ソフトウエアのインストールや設定を行う時に、AtlasPC への接続を簡単に行えるよ

うに、プラントのLANの IPアドレスと互換性のあるアドレスを、AtlasPCの IPアドレスに使用した方が、

作業は楽になります。最終的な IP アドレスは、後で再設定しても差し支えありません。 
 
ステップ４： － AppManager でスタティック IP アドレスを新しい値に変更する： 
制御装置が接続されているネットワークの設定を、次のように変更します。この作業にはバージョン 2.0 以上の AppManager
と Footprint レビジョン 2 以上（または Footprint レビジョン 1 と Service Pack 2 以上）が必要です。 
 
1. 制御装置に接続されているPC 上で、AppManagerを開きます。ヘルプ・ファイルappmanager.chmをまだ読んでい

ない場合、まず、このヘルプ・ファイルを読んでください。 
 

注： Footprint は、Unipress Software 社が製作した、トラブルに関する質問の受付けや、トラブル情報と解決方法のデー

タベース構築支援や、解決方法の検索支援などを半自動的に行うソフトウエアです。 
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2. AppManagerのウインドウ画面でAtlasPC制御装置の（ネットワーク上の）コンピュータ名を見る事ができるはずです。

AtlasPCのコンピュータ名を反転表示にしないでください。反転表示にすると、タイムアウト・ディレイが発生します。もし、

このコンピュータ名がウインドウ上に表示されない場合は、ステップ３に示されたように接続されているか、LinkのLED
は正しく点灯しているかどうか、チェックしてください。 

 
 注注注：：：   
 AppManagerのウインドウに、PCに接続されているAtlasPC制御装置のコンピュータ名が表示され

ない場合、PCのDOSコマンド・プロンプト画面で、Pingコマンドを使用して、ポートに接続されている制

御装置のコンピュータ名か IPアドレスに向けて、（Echo requestの）メッセージを送ってみます。この章

の「ネットワークのピンギング」の所を参照してください。Pingコマンドが正しく実行されたなら、PCのネ

ットワークの設定を変更する必要があるかも知れません。ご使用中の、ネットワーク管理者に相談してく

ださい。 
 
AppManager のバージョンが 2.0.0.3 以下である時に、制御装置のネットワーク識別子が制御装置に

接続されている PC のネットワーク識別子と異なっているならば、AppManager で制御装置の名前を

反転表示にすると、制御装置は RPC サーバを探しに行くか、場合によっては App- Manager がプロ

グラムの実行を停止します。RPC サーバの探索に行った場合、探索に数分かかる事があります。サー

バの探索に行った時に AppManager が実行を停止した場合、４、５分待ってアプリケーション・プログ

ラムが応答しなければ、CTRL キーと ALT キーと DEL キーを同時に押して Task Manager を起動し、

Task Manager で AppManager を強制終了させます。そして、ステップ４からやり直してください。 
 
3. AppManager 画面のトップ・ヘッダで Control をクリックし、プルダウン・メニューを表示して、そこで Change Network 

Settings を選択します。 
 
4. 制御装置（の名前）が反転表示になっていないので、新しいポップアップ・ウインドウが現われて、制御装置で実行中の

アプリケーション・プログラムが無い事を確認するように、ユーザに指示します。この制御装置が新規に設置されたもの

であるか、もしくは実行中のアプリケーション・プログラムがひとつも無い事を確認したなら、OK を選択してください。 
 
5. AppManager は、IP アドレスを入力して制御装置を選択するように指示します。下の例では、NTA07887 のイーサネ

ット・ポート#2 を入力しています。 
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6. ネットワーク識別子も変更する場合、IP アドレスのどの部分がネットワーク識別子になるかは、Subnet マスクによって決

まって来る事に注意してください。ネットワーク識別子変更後のドメイン名が実際のネットワークのドメイン名とは異なる場

合がありますので、使用している PC が、ネットワークから切り離されている事、Atlas 制御装置との接続は、ローカル接

続か Host-to-Host 接続になっている事を確認してください。 
 
 警警警   告告告   
 新しく設定した IP アドレスが正しいアドレスではなかった場合、Atlas PC とイーサネット・ポートで

通信する事が不可能になります。この間違って設定された IP アドレスを訂正するには、２番目のイ

ーサネット・ポートから Atlas PC の設定内容を書き換えるしかありませんが、イーサネット・ポート

が１個しか付いていない場合、装置を弊社に返送してください。弊社で、この装置の Compact 
Flash カードをプログラムし直します。 

 

 
 
7. 然るべき IPアドレスを設定したなら、OKをクリックします。新しい IPアドレスは、この制御装置を立ち上げ直した後で、

有効になります。Atlas PC を立ち上げ直す場合、約２分間、Atlas PC の名前が AppManager の画面から消えます。

AppManager の画面に Atlas PC に割り付けたコンピュータ名が現われた時には、IP アドレスが変更されているはず

です。 
 
8. 設定用のPCが接続されているネットワークから、新しいIPアドレスが有効なものであると認められれば、AppManager

の画面上で制御装置に対応するコンピュータ名を反転表示させて、何の制約もなく AppManager を使用する事ができ

ます。 
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ステップ５： 
AppManager で DHCP モードに切り換える 
バージョン 2.0 以上の AppManager と Footprint レビジョン 2（または Footprint レビジョン 1 と Service Pack 2 以上）を使

用して、この制御装置の設定を以下のように変更する事ができます。 
 
1. 使用している PC で AppManager の画面を開きます。ユーザが AppManager に付いてあまり良く知らない場合、ここ

で AppManager のヘルプ・ファイル（appmanager.chm）を良く読んでおいてください。 
 
2. AppManager のウインドウ画面には、Atlas PC のコンピュータ名が表示されるはずです。ここで、AtlasPC のコンピュ

ータ名を反転表示にすると、タイムアウト・ディレイが発生するので、反転表示にしないでください。もし、このコンピュー

タ名がウインドウ上に表示されない場合は、ステップ３に示されたように接続されているか、LinkのLEDは正しく点灯し

ているかどうか、チェックしてください。 
 
 注注注：：：   
 AppManagerのウインドウに、PCに接続されているAtlasPC制御装置のコンピュータ名が表示され

ない場合、PCのDOSコマンド・プロンプト画面で、Pingコマンドを使用して、ポートに接続されている制

御装置のコンピュータ名か IP アドレスに向けて、メッセージを送ってみます。この章の「ネットワークの

ピンギング」の所を参照してください。ピング・コマンドが正しく実行されたなら、PC のネットワークの設

定を変更する必要があるかも知れません。ご使用中の、ネットワーク管理者に相談してください。 
 
AppManager のバージョンが 2.0.0.3 以下である時に、制御装置のネットワーク識別子が制御装置に

接続されている PC のネットワーク識別子と異なっているならば、AppManager で制御装置の名前を

反転表示にすると、制御装置は RPC サーバを探しに行くか、場合によっては App- Manager がプロ

グラムの実行を停止します。RPC サーバの探索に行った場合、探索に数分かかる事があります。サー

バの探索に行った時に AppManager が実行を停止した場合、４、５分待って AppManager が応答

しなければ、CTRL キーと ALT キーと DEL キーを同時に押して Task Manager を起動し、Task 
Manager で AppManager を強制終了させます。そして、ステップ５からやり直してください。 

 
3. [Refresh Control List]のアイコンをクリックして、全ての制御装置の選択を解除します。 
 
4. AppManager 画面のトップ・ヘッダで Control をクリックし、プルダウン・メニューを表示して、そこで Change Network 

Settings を選択します。 
 
5. 制御装置（の名前）が反転表示になっていないので、ポップアップ・ウインドウが現われて、制御装置で実行中のアプリ

ケーション・プログラムが無い事を確認するように、ユーザに指示します。この制御装置が新規に設置されたものである

か、どのアプリケーション・プログラムも実行中では無い事を確認したなら、OK を選択してください。 
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6. AppManager は、IP アドレスを入力して制御装置を選択するように指示します。 
 

 
 
7. ここで、”Obtain an IP address from a DHCP server”を選択します。 
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8. ここでOKを選択すると、Atlas制御装置を再起動するかどうか聞いてきます。OKをクリックしてください。そうすると、こ

のウインドウは AppManager の画面から消えます。先ほど IP アドレスを変更したポートを、Atlas 制御装置が再起動し

ている間であれば、何時でもネットワークに接続する事ができます。ネットワークのリース時間がどんなに長くても、

Atlas PCはネットワーク・サーバが自分自身に対してIPアドレスを設定するのを待っています。サーバがAtals PCに

IP アドレスを設定する事によって、再起動の手順は終了します。Atlas PC をネットワークに接続するに当たって、これ

以上何もする事がなければ、設定用の PC と Atlas 制御装置をネットワークに接続して、Atlas の電源を一旦切って、入

れ直します。Atlas 制御装置の立ち上げが終わったなら、Atlas 制御装置に割り付けたコンピュータ名を AppManager
でも Explorer でも見る事ができます。 

 
 
 注注注：：：   
 これから接続しようとする Atlas 制御装置の IP アドレスがスタティック IP アドレスであり、しかも、以前

DHCP モードでネットワークに接続されていたのであれば、これから接続するネットワークのサーバが

コンピュータ名とこれに対応する IPアドレスをネットワーク上のPCに伝えるまでに１時間位かかる事も

あります。Atlas 制御装置に対して、コンピュータ名を指定して Ping コマンドでメッセージを送ったとして

も、返事は返って来ませんし、AppManagerの画面でAtlas制御装置の名前が表示される事もありま

せん。こうなった時に問題を素早く解決する唯一の方法は、PC を再起動する事です。 
 
 
 注注注：：：   
 Atlas 制御装置のコンピュータ名が AppManager に表示されない場合、この制御装置のネットワーク

の設定がどうなっているか調べてください。設定用の PC と Atlas 制御装置をプラント内のネットワーク

から外し、NetMeeting を使用して、制御装置をコンピュータ名で PC に直に接続します。（この章の

NetMeeting の設定の項を参照の事。）Atlas 制御装置のデスクトップ画面を表示して、[Start] → 
Programs を選択します。そして、DOS コマンド・プロンプト画面を開いて、ipconfig と入力します。そう

すると、Atlas 制御装置の、ネットワークの設定内容が表示されます。 
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これで、「最初のセットアップ手順」は、終了しました。これから設置する AtlasPC で、少なくとも１個の TCP/IP
イーサネット・ポートが使用できるので、AtlasPC をこのポートからプラントのネットワークに接続して、これ以
後のセットアップやモニタリングに使用する事ができるようになります。 

 
ステップ６ 
制御装置からツールを取り出す 
 
1. 設定用の PC で Explorer を立ち上げて、Explorer 画面でコンピュータ名を探すか、Start → Find → Computer で

「コンピュータ名」の所にステップ 1 で記録した制御装置のコンピュータ名を入力します。 
 
2. ２、３分以内に、コンピュータ名が見つかるはずです。制御装置のコンピュータ名が表示されたなら、コンピュータを表

すアイコンかコンピュータ名をダブル・クリックします。制御装置に電源を投入して制御装置が立ち上がった後、この時、

初めて PC から Atlas 制御装置にアクセスするのであれば、まず制御装置にログ・イン（Log-in）しなければ、ハード・ド

ライブの内容を見に行く事ができません。ログ・インできたならば、C:ドライブのWoodwardディレクトリ内のファイルを、

通常のファイルと同じように読み書きする事ができます。 
 
• Enter Network Password ウインドウがポップアップ表示されて、”Connect As”と”Password”で接続者名とパ

スワードを聞いてきたならば、両方共、「ServiceUser」と入力してください。入力する時、大文字と小文字の区別に

注意してください。 
 
3. これが、制御装置立上げ後、最初の制御装置への接続であれば、フォルダに関する警告メッセージが表示されます。こ

の制御装置のハード・ドライブを初めて読みに行った時には、フォルダの全ての階層で、この警告メッセージが表示さ

れます。この警告メッセージは、ここで何度も表示されますから、消えてしまうまで、OK をクリックしてください。 
 

 
 
4. Woodward と言う名前のフォルダを開きます。 
 
5. 設定用の PC にまだ AppManager をインストールしていない場合、マウス・カーソルを AppManager に持っていき、

右クリックして、「Send To」を選択し、プルダウン・メニューを表示して「MyDocument」をクリックします。（ファイルの転

送に暫く時間がかかる事があります。）これで、AppManager を C:\MyDocument のフォルダにコピーできました。 
 
6. AppManager のヘルプ・ファイルである AppManager.chm も同様に、C:\MyDocument にコピーします。 
 
7. NetMeeting のファイル nm30.exe も同様に、C:\MyDocument にコピーします。 
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AppManager － Control Information 画面 

 
この AppManager 画面は、CPU ボードと、これに付属している C ドライブの制御情報を表示します。 
 
この IP アドレスにより、設定用の PC が接続されているネットワークで制御装置をアクセス可能である事を確認し、それからコ

ンピュータ名を反転表示にし、［Control Information］のアイコンをクリックします。 
 

 
 

NetMeeting の設定 
 
ソフトウエアのインストール 
Microsoft 社の NetMeeting を使用する為には、PC からネットワークを経由して制御装置にログ・オンした後で、このソフトウ

エアをインストールしなければなりません。このプログラムは、（プログラム名nm30.exe の）自己インストール・アーカイブとし

て提供されます。クライアント・マシンとなる PC に簡単にインストールできます。 
 
1. 設定用の PCに、制御装置からNetMeetingをコピーします。この章の「ステップ６：制御装置からツールを取り出す」の

ところを参照してください。 
 
この操作が終了すると、スタート・メニューとデスクトップにショートカットが置かれます。NetMeeting を使用する前に、必要な

設定を行わなければなりません。 
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NetMeeting の設定 
2. アプリケーション・プログラムが最初に走る時に、NetMeeting はユーザ情報を聞いてきます。全ての入力欄に然るべき

データを入力しなければ、次に進む事はできません。 
 
 エンド・ユーザの情報を入力 “Do not list my name in the directory”を選択 

 
 
3. 次の画面では、ユーザがどのモードで制御装置と通信したいか、聞いてきます。普通、ここで「Local Area Network」

を選択します。しかし、それ以外の通信モードを使用する事もできます。これから使用する通信モードを選択します。 
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4. 後続のセットアップ画面では、終わりまでデフォルトの項目を選択します。これで、初めて NetMeeting のプログラムが

走ります。Menu から、Tools → Options と選択して行き、Options のダイアログ画面で Security のタブをクリックして

Security 項目の設定ウインドウを開きます。ここで、”I prefer to make secure outgoing calls”のオプションを有効にし

ます。これで、Netmeeting の設定が終了しました。 
 
  Security のタブをクリックして 
 Menu から Tools→Options を選択 “I prefer to make a secure outgoing calls”のオプションを選択 
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NetMeeting による接続 

 
制御装置への接続画面 
 

Microsoft NetMeeting を起動してコンピュータ

名（NTA18815）を入力し、制御装置に接続する。

代わりに、IP アドレス（190.14.99.220）を入力して

も良い。 

 
UserName: ServiceUser 
Password: ServiceUser 

 

 
 

 
制御装置へのログ・オン実行中画面 
 

CONTROL メニューから 
Ctrl+Alt+Del キーを送る。 
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制御装置へログ・インする 
 

制御装置のロック解除 
 

UserName: ServiceUser 
Password: ServiceUser 

 

 
制御装置のデスクトップ画面 
 

これで、制御装置のデスクトップ画面を表

示して、設定値の入力やファイルの操作

が可能になる。 
 

アプリケーション・ソフトウエアの起動、 
停止、デバッグ、およびファイルの書き換

えや操作が可能になる。 
 

ネットワークの設定値を調整／変更可能 
 

 
 

NetMeeting でネットワークの設定を変更する 
 
 
1. NetMeetingの操作方法をよく知らないユーザは、まず、「NetMeetingの設定」と「NetMeetingによる接続」の項を、よ

く読んでください。 
 
2. 制御装置のデスクトップ画面に接続し、Start メニューから Setting → Control Panel → Network の順でウインドウを

開いて行きます。 
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3. Protocolsのタブをクリックし、Propatiesを選択します。ここで、DHCPモードからスタティック IPアドレスに、ネットワー

クの設定を変更する事ができます。 
 
 注注注：：：   
 上の画面で［Change］のボタンをクリックすると、Computer Name を変更する事ができますが、そ

うすると解りにくくなるので、今は Computer Name を変更しないでください。 
 
IP アドレスの Network 識別子の部分を変更しようとしている場合、IP アドレスの Network 識別子の部

分は Subnet Mask に基づいて決定されるので、新しいドメイン・アドレスがネットワークから受付けら

れない場合もあるという事を考えて、制御装置と設定用PC をネットワークから取り外し、ローカル・モー

ド、または Host-to-Host モードで接続しておいてください。 
 
 警警警   告告告   
 新しく設定した IP アドレスが正しいアドレスではなかった場合、Atlas PC とイーサネット・ポートで

通信する事が不可能になります。この間違って設定された IP アドレスを修正するには、２番目のイ

ーサネット・ポートから Atlas PC の設定内容を書き換えるしかありませんが、イーサネット・ポート

が１個しか付いていない場合、装置を弊社に返送してください。弊社で、この装置の Compact 
Flash カードをプログラムし直します。 

 
• スタティック IP アドレスを新しい値に変更する為には、正しい IP アドレス値と Subnet Mask 値と Gateway 値を

入力しなければなりません。これらの値を設定し直す場合、制御装置を接続しているネットワークのシステム管理

者に、正しい値を設定するにはどうすれば良いか、相談してください。第7 章の「インターネットとイーサネットに

ついて」を参照してください。 
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• Adaptersのプルダウン・メニューでは、Adapter [1]は、常に（CPUモジュールの）Ethernet Port #1の事です。

デュアル・イーサネットの制御装置では、Adapter [2]を選択して、（PC/104 の）Ethernet port #2 を変更してくだ

さい。 
 

• 必要な設定値を入力して、OK をクリックします。そうすると、NetMeeting のウインドウが閉じます。制御装置を再

起動すると、ネットワークの新しい設定値が有効になります。 
 

• 注： これから接続しようとする Atlas 制御装置の IP アドレスがスタティック IP アドレスであるが、以前は DHCP
モードでネットワークに接続されていたのであれば、これから接続するネットワークのサーバが、コンピュータ名と

これに対応する IP アドレスをネットワーク上の PC に伝えるまでに１時間位かかる事もあります。Atlas 制御装置

に対して、コンピュータ名を指定して Ping コマンドでメッセージを送ったとしても、返事は返って来ませんし、

AppManager の画面で Atlas 制御装置の名前が表示される事もありません。こうなった時に問題を素早く解決す

る唯一の方法は、PC を再起動する事です。 
 
 注注注：：：   
 Atlas 制御装置のコンピュータ名が AppManager に表示されない場合、この制御装置のネットワーク

の設定がどうなっているか調べてください。設定用の PC と Atlas 制御装置をプラント内のネットワーク

から外し、NetMeeting を使用して、制御装置をコンピュータ名で PC に直に接続します。Atlas 制御装

置のデスクトップ画面を表示して、[Start]→Programs を選択します。そして、DOS コマンド・プロンプト

画面を開いて、ipconfig と入力します。そうすると、Atlas 制御装置の、ネットワークの設定内容が表示

されます。 
 

• 設定用のPCがログ・オンしているネットワークで、Atlas制御装置の新しいIPアドレスを使用できるのであれば、

AppManager で制御装置を表すコンピュータ名を反転表示して、AppManager を何の制約もなしに使用する事

ができます。 
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GAP でのデュアル・イーサネットの設定 

 
適正な IP アドレスとサブネット・マスクを指定すれば、2 番目のイーサネット・カードを使用する事ができます。しかし Modbus
による通信を行うならば、使用できる通信ポートはどれかを Modbus ブロックが判別できるように、UDP_P ブロックを GAP プ

ログラム時に組み込んでおかなければなりません。UDP_Pブロックは、NT_CPU ペアレント・ブロックに接続しなければなり

ません。 
 
図2-3 を参照の事。 
1. NT_CPU ペアレント・ブロックで、NT_CPUブロックを開いて RPT2 をクリックして、２番目の ETHER_2入力を追加し

ます。 
 
2. NT_CPU.ETHER_x 入力で、ふたつの UDP_P ブロックの名前を入力します。 
 
3. UDP_P ブロックの UDP_P 出力は、MODBUS_M または MODBUS_S の PORT_x 入力に接続されます。 
 
 注注注：：：   
 プログラムの中に複数のUDP_Pブロックが存在する場合、各S_PORT入力には固有の番号を付けなけ

ればなりません。UDP_P ブロックのヘルプを参照の事。 
 

 
 

図2-3． GAPにデュアル・イーサネットを組み込む場合の例 
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ネットワークのセキュリティとパーミッション 

 
この制御装置のオペレーティング・システムは、正しいパス・ワードを入力しなければ、制御装置にログ・インして、制御装置内

のデータをパーミッション（データ・アクセスの許可レベル）に基づいて読み書きできないようになっています。ユーザの設定

をある特定のサイトに合わせるには、ユーザ・リスト修正の機能を使用します。 
 
以下のユーザ名とパスワードを使用すれば、Atlas 制御装置にアクセスする事ができます。Administrator としてのログイン

は、弊社のサービス・マンか、これと同等の資格を有する技術者専用のユーザ名です。ユーザ名とパスワードを入力する時は、

大文字と小文字の区別に注意してください。 
 

ユーザ名 パスワード パーミッション 
Administrator ∗∗∗∗∗∗∗∗ Read, Write, Execute 
ServiceUser ServiceUser Read, Write, Execute 
operator operator Read only 

表2-1． ユーザ名とパスワードのリスト 
 

ネットワークのピンギング 
 
DOS の Ping コマンドは、コマンド・プロンプト画面から入力します。このコマンドは、次の事を行う為に使用します。 
• ネットワーク上に、特定の IP アドレスが付いた装置が存在するか、調べる為。例えば、弊社の装置のイーサネット・ポー

トをネットワークに接続する前に、ネットワーク上でこのテストを行い、他の装置が弊社の制御装置をアクセスする時に、

固定した IP アドレスを使用しているかどうか、テストする。 
• 弊社の制御装置のコンピュータ名も IP アドレスもわからない時に、これがネットワークに接続されている事、および、他

の装置がこれと通信を行っている事を、制御装置の TX LED が点滅するのを見て確認する。 
• 制御装置の TCP/IP イーサネット・ポートがネットワークに接続可能である事を確かめる。 
 
イーサネットからAtlas制御装置に何かメッセージを送っても何の応答も無いようであれば、Pingコマンドを使用して、制御装

置が通信可能であるか確かめます。DOSのPingコマンドを実行すると、制御装置にパケットを送信して、応答が返ってくるか

どうか、イーサネットをモニタします。応答が正常に返ってくるならば、制御装置のIPアドレスと、パケットのトラベル・タイム（転

送時間）が表示されます。これで、ハードウエアが正常に動作している事がわかります。 
 
ピンギングの方法 
Atlas PC 制御装置に Ping コマンドを送るには、コンピュータ名か IP アドレスを入力して、以下のように行います。 
 
1. Host-to-Host で接続している時には、シールド付きのクロス・ケーブルを使用します。ケーブルに、ハブやスイッチが

付いている場合には、ストレイト・ケーブルを使用します。装置が正しく接続されているかどうかは、緑色のLink LEDが

点灯しているかどうかで判断します。 
2. 設定用の PC で［Start］のメニューから Program を選択し、Command Prompt のショートカットをダブルクリックして、

Ping コマンドを入力します。 
3. 例： c:>ping nta26260 または c:>ping 190.14.98.173 と入力します。図2-4 を参照の事。 
4. Ping コマンドのオプションを見る為には、”ping”と入力して ENTER キーを押します。図2-5 を参照の事。 
5. コマンド・プロンプト画面を閉じるには、”exit”と入力して、ENTER キーを押します。 
 



NT RTOS ソフトウエア・ツール マニュアル JA26103 

  Woodward 28

 

 
 

図2-4． コンピュータ名とIPアドレスを使用してDOSのPingコマンドを使用する 
 

 
 

図2-5． IPアドレスを付けてPingコマンドを入力し、コンピュータ名を取得する 
 

注注注：：：   
 AtlasPC 制御装置のイーサネット＃１ポートに向けて Ping コマンドを使用する場合、Ping コマンドを使

用する度に、赤い TX LED が点灯する事を、上側のカバーの隙間から確認する事ができます。 
 

注注注：：：   
 Ping コマンドに”-t”のオプションを付けると、［CTRL］+［C］キーを押すまで、Ping コマンドを連続して実

行し続けます。 
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イーサネットの分散 I/O 

 
BootP は、イーサネットの分散I/O として動作する制御装置で必ず使用されるソフトウエア・ツールであり、その他の実行可能

ファイルと一緒に弊社からユーザに提供されます。このツールは IP/UDP ブートストラップ・プロトコルで、これを使用すると、

クライアント・マシンが自分の IP アドレスを見つける事ができます。このプロトコルはサーバとして動作し、何かのリクエストが

来るのを常に待っています。サーバがリクエストを受け取ると、リクエストの MAC アドレスと一致するエントリを BootP データ

ベースの中に探します。サーバが一致するエントリを見つけると、一致したエントリの後続の部分に格納されている IP アドレ

スを付けて応答メッセージを送信します。 
 
分散I/O に付いては、AtlasPC ハードウエア・マニュアル 85586V2 の第２巻に相当詳しい解説が載っていますので、そちら

をご覧ください。 
 
例えば、取り付ける事ができる分散I/O ノードに、Modicon 社のシングル・エンデッド（片側が GND ライン）の 16 チャンネル

のアナログ・モジュール（170 AAI 140 00）があります。 
 
このモジュールの入力チャンネルは、±10 V 入力か、±5 V 入力か、4-20 mA 入力として設定する事ができます。 
 

 
 
モジュールに IP アドレスを設定する 
各分散I/O 装置に対しては、適当な IP アドレスが指定されます。この IP アドレスの設定方法に付いては、RS-232 通信ライ

ンからターミナル・エミュレータで設定しなければならない装置もありますし、BOOTP というサーバが自動的に設定する装置

もあります。Modicon 社のアナログ・モジュールでは BootP プログラムを使用します。 
 
1 台の Modicon ノードには、そのノードに対して 1 個の MAC アドレスが指定されています。（MAC アドレスは、通常ステッ

カなどに記載されています。）このMACアドレスとIPアドレス、および「Entry name」のフィールドと、その説明に付いては、

（ネットワークの）システム管理者に聞けば教えてもらえます。 
 
この BootP のソフトウエアは、Atlas 制御装置の C:\Woodward のディレクトリに常駐しています。このソフトウエアは、Net- 
Meeting を使用して、別のコンピュータから遠隔操作で起動する事ができます。 
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イーサネット分散 I/O と GAP 
• ネットワークにイーサネット I/O が接続されているかどうかは、GAP の FBUS_M でスキャンします。FBUS_M は、

TCP/IP スタンダードで動作する ModBus で通信を行う分散I/O であれば、どんなものにでも接続する事ができます。

これは、１台の装置とTCPで通信を行うように設計されています。このブロックは、GAPの”Add Hardware”の”TCP/IP 
Fieldbus Block”で見つける事ができます。 

• FBUS_INTA のブロックと FBUS_INTB のブロックは、分散I/O モジュールを初期化する為に使用されます。 
• FBUS_AI、FBUS_AO、FBUS_BI、FBUS_BO、FBUS_AIO の各ブロックは、Modbus でデータの送受信を行う場

合でも使用可能です。 
• GAPのインタフェースに関する質問に関しては、GAPのヘルプを参照してください。イーサネット分散I/Oに関する詳

細な質問に付いては、直接弊社にお問い合わせください。 
• 入力チャンネルを電圧入力、または電流入力に設定する方法に付いては、Modicon 社のマニュアルを参照してくださ

い。分散I/O で測定した生のデータを、Atlas でどのように加工するかと言う事に付いても、このマニュアルで説明して

います。 
• 上記のブロックで、転送されてきた生のデータを、どのようにして電圧値や電流値に変換するかという事も、各ブロック

の GAP ヘルプで解説しています。 
 
より詳細な解説に付いては、弊社のマニュアル 85586V2：AtlasPC Hardware Manual, vol. II (の分散I/O に関する説明)
を参照してください。 
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第 ３ 章 
アプリケーション・プログラムの設定方法 

 
 

概  要 
 
Atlas制御装置を動作させるには、その前に、アプリケーション・プログラムを作成して、制御装置にダウンロードしなければな

りません。この章では、制御装置に搭載するソフトウエアを、作成したり、ダウンロードしたり、改訂したりする時に、システム・

エンジニアがどのような手順で仕事を行うかという事を、解説しています。 
 

アプリケーション・ソフトウエアの作成 
 
アプリケーション・ソフトウエアは、第１章で説明したように、弊社の GAP と Coder を使用して作成します。GAP のアプリケー

ション・プログラムでは、入出力チャンネルの種類、本数、および信号の入出力レンジの設定、それから制御装置内の信号の

流れを指定します。弊社の Ladder Logic を使用する場合、Ladder Logic の入出力信号に付いても GAP で定義して、本体

のソフトウエアとリンクしなければなりません。プログラムの作成が完了すると、GAP でコンプリートネス・チェックを行います。

コンプリートネス・チェックをパスすると、.CDRファイルが作成されます。弊社のCoderは、この.CDRファイルを読み込んで、

ターゲット・ソフトウエア（拡張子名はEXEとRTSS）を作成します。このターゲット・ファイルは、最終的にAtlas制御装置の不

揮発性メモリに転送されます。 
 

アプリケーション・ソフトウエアのダウンロードと実行 
 
アプリケーション・ソフトウエアをAtlas制御装置に転送するには、AppManagerのソフトウエア・ツールを使用します。最初に、

制御装置とネットワークで接続されている PC に、AppManager をインストールします。次に、AppManager の Transfer 
Application Files のコマンドを使用して、.EXE ファイルと.RTSS ファイルを制御装置の不揮発性メモリ（フラッシュ・ディスク）

に転送します。AppManager で、アプリケーション・ソフトウエアが制御装置の然るべきディレクトリ（フォルダ）に格納された事

を、確認してください。 
 
 
 注注注：：：   
 新しいユーザやワークステイションからアプリケーション・ソフトウエアをチェックしたり、走らせたりする

為には、まず、AppManagerで正しくログ・インしなければなりません。第2章の「ネットワークのセキ

ュリティとパーミッション」、および表2-1 を参照の事。 
 
（.EXE と.RTSS の）アプリケーション・ファイルを制御装置に転送したならば、以下の手順に従って、アプウリケーション・プロ

グラムを起動します。 
 
1. 制御装置のコンピュータ名を選択します。Control List では、ネットワークに接続された全てのコンピュータの名前を一

覧表に表示します。この一覧表で制御装置の名前を選択すると、（右側のウインドウの）アプリケーション・ソフトウエアの

一覧表の表示が変わります。 
 
2. この一覧表で、これから走らせようとするアプリケーション・ソフトウエアを選択し、反転表示させます。 
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3. アプリケーション・ソフトウエアを走らせるには、［Start Application］ボタンをクリックします。そうすると、AppManager

はアプリケーション・プログラムを起動します。プログラム初期化の実行状況が、ウインドウ画面の右下に表示されます。

停止しているアプリケーション・プログラムの名前をダブル・クリックすれば、そのプログラムが走り始めますし、走ってい

るアプリケーション・プログラムの名前をダブル・クリックすれば、そのプログラムは実行を停止します。 
 

 
 
アプリケーション・プログラムが走り始めると、GAP で動作するように指定したモジュール上の LED が消灯し、AppManager
では、アプリケーション・プログラムがAutoStartになっている事を表示します。AutoStartになっていると言う事は、この制御

装置の電源を切って入れ直すか、この制御装置（の CPU）が何かの理由でダウンすると、制御装置が正常な状態に復帰した

時点で、このアプリケーション・プログラムは自動的に再起動されると言う事です。このように設定すると、制御装置に電源を投

入する度に、ネットワークから制御装置にログオンして、AppManager でアプリケーション・プログラムを起動する必要がなく

なります。 
 
AppManager の Stop コマンドを使用してアプリケーション・プログラムを停止した場合、そのプログラムに関する App- 
Manager の AutoStart の設定は消去されます。 
 
   注注注：：：   
 最初にアプリケーション・プログラムを起動すると、アプリケーション・プログラムの変更可能な設定値を

全て記録したファイル（拡張子名は EE）を作成します。このファイルは、.EXE ファイルや.RTSS ファイルと

同じディレクトリに作成されます。 
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実行するアプリケーション・プログラムの変更 

 
実行するアプリケーション・プログラムを変更するには、現在走っているアプリケーション・プログラムの名前を反転表示にして、

［Stop Application］のボタンをクリックします。 
 

 
 
AppManager は、ログインするかどうか、聞いてきます。 
 

 
 
AppManager は、本当にアプリケーション・プログラムを停止するかどうか、確認する為のメッセージを表示します。 
 
プログラムを停止するには、［Yes］を選択します。アプリケーション・プログラムの実行が停止すると、Application Name の一

覧表と Status の表示欄でその事が表示され、そのプログラム名は、AutoStart のリストから消去されます。 
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次に、アプリケーション・プログラムをAtlas 制御装置に転送しなければならないはずです。（Application Name の一覧表に、

このプログラム名が既にあるならば、この手順は省略します。）設定用の PC から制御装置の不揮発性メモリにアプリケーショ

ン・プログラムを転送するには、［Transfer App Files］のボタンをクリックします。 
 
アプリケーション・プログラムが、まだ制御装置にロードされていない場合、 
• Control Name で正しいコンピュータ名を選択した事を確認し、［Transfer App Files］をクリックします。制御装置に転

送するアプリケーション・プログラムを選択する為のダイアログ・ボックスが表示されます。 
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• 転送すべきアプリケーション・ソフトウエアの.EXE ファイルか.RTSS ファイルのどちらかを選択し、［Transfer］ボタンを

クリックします。そうするとAppManagerは、.EXEファイルと.RTSSファイルを両方共制御装置に転送します。同じ名前

のファイルが存在する時に、既存のファイルに上書きする場合、そうして良いか、確認するメッセージが表示されます。

アプリケーション・ソフトウエアが現在走っている時に、そのソフトウエアに新しいソフトウエアを上書きする事はできませ

ん。 
• アプリケーション・ソフトウエアを転送した後、転送したソフトウエアの名前が Application Name の欄に表示されます。

これから走らせるプログラムの名前を選択し、［Start/Stop Application］ボタンをクリックすると、プログラムは走り始めま

す。 
 

 
 
ステイタス・メッセージの表示画面では、アプリケーション・プログラムが初期化を行っている事と、その初期化の実行状況を表

示します。 
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アプリケーション・ソフトウエアが初期化を終了したならば、ステイタス・メッセージの表示画面にプログラムが実行されている

事、その起動モードは AutoStart である事が表示されます。 
 
必要であれば、アプリケーション・ソフトウエアの名前を反転表示し、［Delete App Files］のボタンをクリックする事により、もし

そのソフトウエアが「実行中」でなければ、この制御装置の不揮発性メモリの古いアプリケーション・ソフトウエアを消去する事

ができます。 
 

制御装置の再起動 
 
この制御装置は、電源投入によりリセットされるようになっていますので、装置を再起動するには、電源を切って、入れ直してく

ださい。制御に使用するアプリケーション・プログラムの設定はAutoStartになっているはずですから、電源を再投入すると、

自動的に走り始めるはずです。 
 
アプリケーション・プログラムのみを再起動させるのであれば、AppManager の Restart Application コマンドを使用します。

このボタンは、選択しているアプリケーション・プログラムを再起動させます。 
 
   注注注：：：   
 現在走っているプログラムに対してでなければ、Restart Application コマンドを使用する事はできな

いので、制御装置で、現在「実行中」の状態ではないアプリケーション・プログラムを再起動する事はで

きません。 
 
〖デバッグ情報〗－電源の再投入により制御装置が正常に再起動しないか、アプリケーション・プログ

ラムの再起動時に何らかの異常が生じた場合、Atlas制御装置のCOM1やCOM2通信ポートへの通

信ケーブルを外して、もう１度起動してみます。COM1 や COM2 通信ポートに接続されているケーブ

ルを取り外すと正常に動作するならば、アプリケーション・プログラムを走らせる前に、Atlas 制御装置

のCOM1やCOM2へ送信したメッセージを全て消去しなければなりません。このようにできない場合、

アクティブなシリアル・ポートを、Atlas CPU モジュールの COM1 や COM2 通信ポート以外の通信ポ

ート、例えば SmartCore モジュールのシリアル・ポートなどに切り換えてみます。 
 

調整可能な設定値の管理 
 
調整可能な設定値（Tunables）とは、（GAP のソフトウエアを組み直さなくても）通信ラインで接続された PC から変更できる、

アプリケーション・プログラムの変数です。アプリケーション・プログラマが、GAP でアプリケーション・プログラムを作成する時

に、ブール値やアナログ値や整数値にアスタリスク（∗）を付けて、調整可能範囲を指定すれば、その値を、「調整可能な設定

値（可調整値）」にする事ができます。 
 
調整可能な設定値のデータは、制御装置の中の拡張子がEEになっているファイルに、２進形式で格納されます。この.EEフ

ァイルは、AppManager の［Retrieve App Files］や［Transfer App files］のコマンドで、.EXE ファイルや.RTSS ファイルと

一緒に転送する事はできませんので、AppManager の［Retrieve App Files］コマンドを使用して、オペレータが自分でコピ

ーしなければなりません。 
 
アプリケーション・プログラム実行中に調整可能な設定値を見たり、変更したりするには、弊社の GAP モニタや MicroPanel
や WatchWindow などのツールを使用します。 
 
GAP で作成した調整可能な設定値を PC に転送して表示したり、調整したりするには、様々な方法があります。そして、制御

装置にダウンロードされたアプリケーション・ソフトウエアの中の全ての調整可能な設定値を（１枚の記録文書の形で）見るに

は、ふたつの方法があります。 
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制御装置にロードされたアプリケーション・ソフトウエアから、調整可能な設定値を読んできて１枚の文書の形で表示したり、

調整したりする為には、以下のようにします。 
1. GAP での設定は不必要です。.CFG ファイルは、MicroSoft の Notepad や Word や Excel で開く事のできる ASCII

ファイルですが、このファイルを制御装置から読み込むには WatchWindow を使用します。WatchWindow では、設

定値の名前と現在の値を表示する事ができますが、上限値と下限値を表示する事はできません。オペレータは、設定

値を変更し、その値をファイルに格納し、ファイルを制御装置に転送する事ができます。 
• （イーサネット・ポートを使用する）WatchWindow IIの場合－ExplorerウインドウのIPアドレスを右クリックして、

App Settings の Save to File を選択する。 
• （シリアル・ポートを使用する）Watch Window Professional と Watch Window Standard の場合－Explorer ウ

インドウのヘッダ・タブを右クリックして、App Settings の Save to File を選択する。 
2. GAP の中で、INTERFACE ブロックと TUNE_VARS ブロックを使用してシリアル通信ポートやイーサネット・ポート

（の動作モードなど）を設定します。（詳細は、Interface Tools と Common SIO Port Configuration の下にある GAP
のヘルプ・ファイルを参照の事。）そして、Control Assistantツールを使用して、拡張子がCNFになっている調整可能

な設定値リストのファイルを転送して、中身を見たり、比較したり、カテゴリ等に従って分類したり、制御装置に格納し直し

たりする事ができます。 
 
GAP のアプリケーション・ソフトウエアで、変更可能な設定値を取得して、調整する。 
1. GAP のヘッダから、File → Database → Export Tunable List to Database を選択します。こうすると.MDB ファイル

ができますが、このファイルはMicrosoftのAccessで開く事ができます。ここで、設定値名、その公称値、下限値、上限

値、タイプを見る事ができます。このデータは、変更した後で、制御装置のアプリケーション・ソフトウエアに格納し直す

事ができます。 
2. GAPのヘッダから、File → Create ASCII File → Tunable List Fileを選択します。こうすると（拡張子名がTUNとい

う）ASCIIファイルができますが、このファイルはMicrosoftのNotepadやWordやExcelで開く事ができます。このフ

ァイルには、設定値名とその現在の値が記載されていますが、上限値や下限値は記載されていません。オペレータは、

設定値を変更してファイルに格納し、WatchWindow を使ってこのファイルを、現在アプリケーション・プログラムを実行

している制御装置に転送する事ができます。 
3. 調整可能な設定値（tunables）を、.CFG ファイルから GAP に取り込みます。制御装置の設定値の調整が完了して、こ

の調整済みの設定値を GAP のアプリケーション・ファイルに取り込みたい場合、GAP のヘッダから、File → Import 
Watch Window Tunables を選択し、設定値をアップロードします。 

 
AtlasPC 制御装置のサービス・パックのインストール 

 
Footprint release（ソフトウエアの基本的な部分に対する改訂）を行う合間に、小幅な改良が、弊社のソフトウエアにしばしば

行われる事がありますが、サービス・パックを使用して最新のソフトウエアを AtlasPC にダウンロードする事ができます。 
このサービス・パックは、弊社のインターネット・ウエブサイトからダウンロードする事ができます。 
 サイト名は、http://www.woodward.com/ic/softwareです。 
 
1. 弊社のウエブサイトに入って、その指示に従いながら、ウエブサイトからサービス・パックをダウンロードして、設定用の

コンピュータのハードディスクに格納します。 
 
2. AppManagerを使用して、ヘッダからControlを選択し、プルダウン・メニューを表示して、その中から”Install Service 

Pack”を選択します。 
 
ここで、ソフトウエア・ライセンスに関する合意書が表示されますので、これに正しい入力を行ってライセンス契約に合意

しなければ、先に進む事ができません。 
 
3. 設定用コンピュータで、既にダウンロードされたサービス・パックが格納されているハードディスク・ドライブを選択して、

［Open］をクリックします。そうすると、サービス・パックは自己インストールし、その後で AtlasPC は再起動されます。 
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第 ４ 章 
ServLink と Watch Window 

 
 

概 要 
 
Watch Window II はイーサネット・ポートを使用しますが、GAP でアプリケーション・ソフトウエアを作成する時に、その為の

プログラムを組んだり、設定したりする必要はありません。Watch Window II は OPC サーバを使用しますが、このサーバは、

GAP のアプリケーション・プログラムが起動された時に、同時に起動されます。 
 
Watch Window ProfessionalもWatch Window Standardも、弊社のソフトウエアであるServLinkサーバ・プログラムを使

用して（Atlas制御装置と）シリアル通信を行う時にDDEで送信データや受信データを交換する事により、ServLinkに対して

（要求や指示を出す）クライアント・ソフトウエアとして動作します。GAP でソフトウエアを作成する時には、このふたつのソフト

ウエア・ツールを使用する事ができるようにプログラムを組まなければなりません。 
 
Watch Window を弊社のウエブサイトからダウンロードすると、ServLink も一緒に付いて来ます。 
 
Watch Window には、以下の機能があります。 
• ServLink DDE サーバを使用した、調整可能な設定値へのアクセス（読み書き） 
• Watch Window で読んだ様々な設定値の、格納と、格納したデータの取り出し 
• 取得可能なデータの階層構造と内容の表示 
• 設定値に関する簡単な解説を表示 
 

ServLink の為の GAP の設定 
 
AtlasPC 制御装置がシリアル・ポートを介して ServLink サーバとシリアル通信を行えるようにする為には、GAP のアプリケ

ーション・ソフトウエアを以下のように設定します。 
 
• SIO232PORT ブロック、または SIOPORT ブロックを、次の図のようにプログラムします。SmartCore ボードのシリア

ル入力は最高115200 baudのレートで通信できますが、CPUボードのシリアル通信ポートは最高57600 baudでしか

通信できません。GAP で設定する制御装置の通信ポートの設定と、設定用PC の通信ポートの設定が同じであれば、

ボーレイトが何であろうと、通信は可能です。非標準の設定で、重要ではあるがしばしば見落とされる事柄に、設定値3
の Endline（End of line Character）の入力と、設定値2 の IGNCR（Ignore Carriage Return）入力があります。 

• SIO232PORT ブロックの出力は、TUNE_VAR ブロックの SL_PORT_x 入力に入ります。 
• INTERFACEブロックを使用して、そのTUNE_VARS入力にはTUNE_VARブロックの出力信号を接続しなければ

なりません。 
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参考：この SIO232PORT ブロックは、SMARTCOR_S のようなペアレント・ハードウエア・ブロックの中に存在する。 
 

シリアル・ポートで Watch Window を使用する場合 
 
1. 前節で説明したように、ServLinkによりPCと通信するようにGAPで設定した制御装置のシリアル通信ポートと、PCの

シリアル・ポートを、ヌル・モデム・ケーブルで接続します。 
2. 使用している設定用PCのServLinkプログラムを起動します。そして、PCが使用する通信ポートやボーレイトを選択し

ます。通信のモードは、ポイント・ツー・ポイントです。図4-1 を参照の事。 
• ServLink サーバに関する詳細な説明は、オンライン・ヘルプを参照してください。 

3. こうすると、アプリケーション・ソフトウエアに関する情報が制御装置から吸い上げられ、拡張子名が netというファイルが

作成されます。 
4. この.net ファイルに、適当な名前を付けて保管してください。このファイルは、これから作成する Watch Window 画面

に関係します。 
5. Watch Window ProfessionalかWatch Window Standardを開きます。図4-2を参照の事。新しいファイルを開いて

ください。そうすると、シートを追加して、ウインドウを作成する事ができます。 
 
 
 注注注：：：   
 アプリケーション・ソフトウエアに僅かな変更を行ったか、バージョンが違う GAP Coder でアプリケー

ション・プログラムを作成し直した場合、以下のようにすると、以前作成した Watch Window を使用す

る事ができます。 
 1. アプリケーション・ソフトウエアを Atlas 制御装置に転送し、プログラムを走らせます。 
 2. 新しい Servlink ファイルを開いて、以前の.net ファイルのファイル名を付けて格納します。 
 3. 以前の Watch Window を開きます。 
 • メッセージ・ウインドウが現われて”The control ID has changed”と表示したなら、Watch 

Window の.wwi ファイルを Notepad（メモ帳）で開いて、ServLink ウインドウで表示された

IDに一致するように、各行の IDを変更します。変更し終わったなら、.wwiファイルを格納して、

もう一度Watch Window を開きます。 
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図4-1． ServLinkの画面 

 
Watch Window で AtlasPC に接続して、内部のデータを読み書きする事ができますが、全ての機能が使用できるわけでは

ありません。事前に必要な操作を加えておかなければ、その機能を正しく使う事ができないようなものもあります。Explorer の

左側ウインドウの下にある.net ファイルのタブにマウス・カーソルを持って行って、右クリックすると、以下の機能が表示されま

す。（図4-2 を参照の事。） 
• アプリケーション・ソフトウエアのロード。 
• ファイルへのコンフィギュレーション・データの格納。 
• ファイルからのコンフィギュレーション・データのロード。 
• リセット。 
• コンフィギュア・モードへの移行。 
• 設定値の格納。 
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図4-2． Watch Windowの画面 

 
Watch Window の機能 

 
Load Application（アプリケーション・ソフトウエアのロード） 
• この機能は、AtlasのNTオペレーティング・システム上でサポートされていません。この機能は、AppManagerが実行

します。 
 
Configuration/Save to File（ファイルへのコンフィギュレーション・データの格納） 
• この機能は、サポートされています。 
 
Configuration/Load from File（ファイルからのコンフィギュレーション・データのロード） 
• この機能はサポートされていますが、以下のような操作を行わなければ、正しく動作しません。 

1. この機能を選択すると、Watch Window は画面に”Shutdown the control”と表示しますので、マウスで YES
をクリックしてください。 

2. Watch Window は、”Enter Configure Mode”と表示しますので、YES をクリックしてください。そうすると、コ

ンフィギュレーション・ファイルは制御装置にアップロード（転送）されます。 
3. ファイルのアップロードが完了すると、WatchWindow は画面に”Restart the Control”と表示しますので、

NO をクリックしてください。Watch Window で、アプリケーション・プログラムの起動や停止、すなわち再起動を

行う事はできません。 
4. NO をクリックすると、WatchWindow と ServLink をシャットダウンする事により、プログラムの実行を止める事が

できます。AppManager を使用してアプリケーション・プログラムを再起動させると、このプログラムは新しいコン

フィギュレーション・ファイルに基づいて動作します。 
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Reset（リセット） 
• この機能は、サポートされていません。この機能は、AppManager で実行します。 
 
Enter Configure Mode（コンフィギュア・モードへの移行） 
• コンフィギュア・モードとサービス・モードは、Watch Window でサポートされていません。 
 
Save Values（設定値の格納） 
• この機能は、サポートされています。この機能は、GAP で作成したアプリケーション・ソフトウエアの調整可能な設定値

を Atlas 制御装置の C:\Woodward\Applications のディレクトリに格納する為に使用します。ファイルの拡張子は、ee
です。 

 
 注注注：：：   
 Watch Window に関する詳細は、このソフトウエアのオンライン・ヘルプを参照してください。 
 
 注注注：：：   
 GAPで行ったシリアル・ポートの設定をチェックするには、MicroPanelかWatch Window IIを使用し

なければなりません。 
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第 ５ 章 
MicroPanel 

 
概 要 

 
このソフトウエア・ツールは、制御装置がプログラムを実行している時に、GAP で作成したアプリケーション・ソフトウエアの内

部パラメータを表示する為に使用します。GAPでアプリケーション・ソフトウエア作成時に、MicroPanelインタフェースの設定

をしておかなければなりません。 
 
MicroPanelは、AtlasPC制御装置のC:\Woodwardディレクトリ（フォルダ）に格納されており、NetMeetingを使用して他の

コンピュータから開く事もできますし、MicroPanel を自分の PC にコピーした後で、ネットワークで接続された AtlasPC 制御

装置の MicroPanel ウインドウを開く事ができます。 
 
このツールは、アプリケーション・ソフトウエアがシリアル・ポートを介して ServLink/Watch Window と通信するように設定さ

れているにも拘わらず、シリアル・ポートの設定が正しく行われていない為にシリアル・ポートが正常に動作しない時に、役に

立ちます。ユーザは、MicroPanel上で動作するNetMeetingを使用して、イーサネット・ポートからシリアル・ポートの設定値

を、変更する事ができます。もうひとつの方法は、WatchWindow II を使用してイーサネット・ポートから制御装置に接続する

方法です。ユーザは、Control To のポップアップ・ウインドウで、AppManager の Control Name の欄に表示されるコンピュ

ータ名のどれかを入力すれば、どの制御装置／コンピュータとでもネットワークを経由してデータをやり取りする事ができます。

（図5-2 を参照の事。） 
 

GAP における MicroPanel の設定 
 
MicroPanelを使用してネットワーク上でAtlas制御装置と通信するには、GAPのアプリケーション・プログラムを下の図のよう

に設定します。そして、NT_CPU のペアレント・ブロックを開き、RPT1 をクリックして、PIPE_1、PIPE_2、PIPE_3、PIPE_4
の入力フィールドを、このブロックに追加します。各入力の名前は、以下の図に示されているように PIPE_P ブロックの名前で

ある CPU.MICROPNL_1、CPU.MICROPNL_2、CPU.MICROPNL_3、CPU.MICROPNL_4 にします。 
 

 
 

図5-1． MicroPanelのGAPの例 
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この制御装置は、PIPE_P ブロック１個で、ネットワークに接続された１個の MicroPanel と通信する事ができます。最大4 個

の MicroPanel に、ネットワーク経由で接続する事ができます。 
 

MicroPanel プログラムの実行 
 
1. マウス付きの PC を用意して、AtlasPC とネットワーク接続します。 
2. PC で NetMeeting を立ち上げ、Atlas 制御装置のデスクトップ画面に接続します。 
3. 制御装置の C:\Woodward のディレクトリに MicroPanel.exe というファイルがありますから、これを開きます。 
4. “This computer (Local)”を選択して、［OK］をクリックします。リモート PC と通信したい場合のみ、コンピュータ名を入

力してください。 
 
 注注注：：：   
 アプリケーション・ソフトウエアのトラブルシューティングは、この制御装置のイーサネット・ポートに接続

された PC などで、MicroPanel や Watch Window II を走らせて行います。シリアル・ポートの設定を

間違って行うと、fault 出力が true になります。Woodward のフォルダにある MicroPanel.exe のプ

ログラムを走らせて、”local control”を選択します。Debug が［Enter］と表示するまで、マウスで左ク

リックを行います。パスワードの 1112 を入力して、［Enter］を押します。GAP serial port setting までス

クロ－ルして行き、そこでデバッグします。 
 
5. MicroPanel を使用する時にわからない所があれば、オンライン・ヘルプを見てください。 
 

 
図5-2． MicroPanelのConnect To画面 



マニュアル JA26103 NT RTOS ソフトウエア・ツール 

 Woodward 47

 
 

 
図5-3． MicroPanelの画面 
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第 ６ 章 
PC/104 Fieldbus 

 
 

概 要 
 
AtlasPC の Fieldbus ネットワークの通信方式などの設定は、以下のような 2 段階の手順で行います。 
1. Profibus や CANOpen や DeviceNet の設定を行う場合、ApplicomIO の CD を使用します。この CD から、必要なコ

ンフィギュレーション・ファイルを取って来て、AtlasPC 制御装置にコピーします。 
2. Fieldbus ボードや、このボードにネットワークで接続されたモジュールとインタフェースするように、GAP のアプリケー

ション・ソフトウエアを組みます。 
 
詳細は、弊社のマニュアル 85586V2：AtlasPC ハードウエア・マニュアル第２巻（分散I/O）を参照してください。 
 

ApplicomIO を CD-ROM からロードする 
 
ApplicomIOのCD-ROMは、自動起動です。設定用PCのオペレーティング・システムが立ち上がった後でCD-ROMをド

ライブに挿入すると、CD-Browser のナビゲイション・ソフトウエアが自動的に起動されます。 
 
ApplicomIO のインストレイション・プログラムは、以下の手順でインストールを実行します： 
• Internet Explorer 5.0 のインストール ― 使用している PC に、Internet Explorer 5.0（IE 5.0）か、それ以降のバー

ジョンがインストールされていない時には、それをインストールするように要求するメッセージが画面に表示されます。

IE 5.0 かそれ以降のバージョンをコピーするまで、この手順を先に進める事はできません。（以下の必須条件を参照の

事。） 
• ライセンス契約の承認。 
• ApplicomIO の前のバージョンが存在する場合、この古いソフトウエアのアンインストレーション（消去）。アンインストレ

ーションが正常に終了するまで、この手順を先に進める事はできません。 
• ユーザ情報（使用者名と会社名）の入力要求。 
• ソフトウエアを書き込むディレクトリの選択。可能な限りデフォルト・パス（ソフトウエアで指定した本来のディレクトリ）に、

ソフトウエアを格納してください。ApplicomIO の以前のバージョンで使用したパスは、よほどの理由がない限り使用し

ないでください。 
• 使用するコンポーネントとプロトコルの選択。各コンポーネントに付いて、（Profibus DP や DeviceNet や CANOpen

などの）項目を選択しさえすれば、その説明が表示されます。 
• ユーザが独自に行うオプションの選択。環境設定／コンフィギュレーション等のファイルの転送。 
• PC に ApplicomIO をインストールし終わったなら、PC を再起動してください。 
 
必須条件： 
• ApplicomIO に属するソフトウエアは、MicroSoft 社の Windows NT 4.0 と Windows 2000 オペレーティング・システ

ムを搭載しているPCでのみ使用可能です。OSにWindows 95やWindows 98を搭載しているPCに、インストール

する事はできません。 
• インストールしようとするPC（コンピュータ）にCD-ROMが付いているか、このPCにネットワークで接続されているコン

ピュータの CD-ROM をアクセスできる事。 
• “Administrator”として、セッションを開く（ログ・オンする）事。（詳しくは、接続している LAN のネットワーク管理者にお

聞きください。） 
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• Windows NT 4.0 の下で、Internet Explorer 5.0 か、それ以降のバージョンがインストールされている事。インストー

ルされていない場合、もし、PC のオペレーティング・システムの言語の設定が、ドイツ語、英語、スペイン語、フランス語、

イタリア語のどれかになっていれば、インストレイション・プログラムは ApplicomIO をインストールするように表示します。

それ以外の言語であれば、その言語に対応した Internet Explorer を持って来なければなりません。インターネットか

ら取ってくる場合、www.microsoft.comにアクセスしてください。 
• インストレイションを開始する前に、PC 上のアプリケーション・ソフトウエアは全て終了しておかなければなりません。 
 
ソフトウエアのアップグレードを行う場合： 
• PC に ApplicomIO の古いバージョンがインストールされている場合、イインンスストトレレイイシショョンンのの手手順順をを開開始始すするる前前にに、、ここのの

旧旧いいソソフフトトウウエエアアをを消消去去ししてておおくく必必要要ははあありりまませせんん。このソフトウエアは、自動的に消去されます。 
 
 注注注   意意意   
 今回の ApplicomIO の新しいバージョンでは、（field bus に接続されている装置の設定を検出して、

自分自身の設定を行うと言う）以前より改良された設定用インタフェースが組み込まれています。この新

しいバージョンでは、バージョン 2.0以前の ApplicomIO を使用して作成した旧い設定が、そのまま使

用される事は決してありません。 
 
インストレイションの手順： 
コンピュータ（PC）に ApplicomIO のソフトウエアをインストールするには、以下のように行います。 
1. Windows NT 4.0 または Windows 2000 を起動します。 
2. ユーザ名を Administrator と入力して、セッションを開きます。 
3. 実行しているアプリケーション・ソフトウエアがあれば、全て終了します。 
4. ApplicomIOのCD-ROMを、CDドライブに挿入します。（CD-Browserのウエルカム・メニューが自動的に走り始める

はずです。そうならない場合には、CD-ROM のルート・ディレクトリに置かれている setup.exe を走らせます。） 
5. 使用する言語を選択します。Documentation を選択した後で、アイコンを使用して Adobe Acrobat 4.0 をロードしてく

ださい。そうすると、ユーザ用の解説書など、全ての文書を読む事ができます。 
6. Install Product を選択します。インストレイションのソフトウエアが走り始め、CD-Browser は自動的に閉じます。 
7. ApplicomIO 2.1 を選択します。 
8. 以下のような質問が記載された画面がポップアップ表示されます。［Yes］をクリックします。 
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Profibus 

 
Profibus ネットワークの設定を行う時には、分散I/O などのスレイブ側、および Atlas 制御装置などのマスタ側の、ふたつの

側の設定を行わなければなりません。 
 
• AtlasPC は、常にマスタになります。 
• マスタとなった装置は、バスを制御する事ができます。マスタの装置がバスにアクセスする権利を持っている時には、そ

の装置は、好きなだけメッセージをやりとりする事ができます。 
• センサやアクチュエータやトランスミッタのような単純な周辺装置、もしくは GE Fanuc VersaMax™ Prifibus Network 

Interface Unit のようなモジュラ I/O ユニットなどがスレイブの装置になります。スレイブ側の装置には、バスにアクセス

する権利がありません。メッセージを受け取った事を確認するか、マスタの要求に応じてメッセージを送り返す事ができ

るだけです。 
• Profibus の通信プロトコルの構造は、国際標準である ISO 7498 に適合するように、Open System Interconnection 

(OSI) reference model に基づいて決定されています。 
• 局数 － リピータを使用しない場合、１個のセグメントに接続する事ができる送受信局数は、最大32 個です。リピータ

を使用すれば、最大127 個まで接続する事ができます。 
• 転送速度 － 9.6 K、19.2 K、93.75 K、187.5 K、500 K、1500 K、3 M、6 M、12 M bits / sec のどれかを選択可能。

バスの長さにより、選択できるボーレイトも制限されます。 
 
Profibus ネットワークに接続する事ができる装置は様々なメーカで製作していますが、接続時の設定が簡単な装置もあれば、

難しい装置もあります。接続方法が限定されている装置は設定も簡単ですが、接続方法の柔軟性が高い装置は、設定も複雑

です。 
 
ネットワークの構造などから考えて、どこのメーカの装置を接続するのが良いか、調査してください。インターネットで各メーカ

のウエッブ・サイトに入れば、そのメーカの装置に関する詳細な情報を入手できるはずです。しかし、まず最初に行って見る

べきウエッブ・サイトは、www.profibus.comです。 
 
アプリケーション・ノート： Applicom/Coder の互換性 
Profibus PC104 モジュールを使用している AtlasPC 制御装置では、以下のようなハードウエアとソフトウエアの組み合わせ

で正常に動作します。 
 
• Applicom Profibus firmware 3.9.0 or 4.0.0 (基板上のラベルに記載) 
• Applicom I/O configuration tool version 1.1 
• Coder 3.01 or 3.02 
• AtlasPC footprint Part number 5414-223 
 
または 
 
• Applicom Profibus firmware 4.0.0 (基板上のラベルに記載) 
• Applicom I/O configuration tool version 2.1 
• Coder （バージョンは 3.03 以降） 
• Part Number 5414-223 以外の AtlasPC footprint 
 
 
 
 
 
 
 
 
 
 
 
注： リピータとは、LANにおける伝送媒体の特性から生ずる伝送路長の限界を超えて伝送路を延長したい場合に使用する、電気信号を再

生／増幅する装置です。 
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Profibus 上で動作する ApplicomIO の設定例 
 
以下の説明は、ApplicomIO 2.1を使用してProfibusの設定を行う事例を、より一般的な形にしたものです。ユーザの皆様が、

ご自分のPCでこのようなProfibus接続の為の設定を行う時には、ApplicomIOのバージョンも上がっている事が予想されま

すから、ここで示す例とは若干違うかも知れません。弊社の Atlas のマニュアルや Profibus 社のマニュアルをよく読んで、

Applicom のユーテリティ・ソフトウエアの使用方法などをよく調べてから、設定を行ってください。 
 
• ApplicomIOをまだCDからインストールしていない場合、この章の「ApplicomIOをCD-ROMからロードする」を参照

して、インストールしてください。 
• どこの会社の製品を使用するかを決定し、それに対応するノードやモジュールを発注して、その会社から.GSD ファイ

ルをもらいます。 
 
 注注注：：：   
 Generic Device を使用すれば、.GSD ファイルが無くても Profibus の設定を行う事ができます。この

機能は、ApplicomIO コンソールの Equipment library のエリアにあります。Generic Device の

equipment の属性を設定し直す事によって、動作特性を変更する事ができます。各モジュールの設定

値を表す文字列の変更や、パラメータ文字列の新規作成は、Expert Mode をアクティブにする事によ

ってのみ可能です。 
 
1. C:\Program Files\ApplicomIO\2.1 のディレクトリ、または ApplicomIO Console という名前のショートカットから

Apcnfgio.exe を起動します。 
2. 設定値を表す文字列を新規作成する場合、File\Configuration Manager\New を選択し、［Board Location］に付い

ては On Local Machine を選択します。 
3. 図6-1 の例を参照してください。Board 1 は、この AtlasPC にインストールされた PC/104 Profibus ボード、すなわち

PC104_DPIO になるはずです。 
4. ［Boards Configuration］と［Diagnostic & Manual Configuration］をダブル・クリックします。 
5. PC104/ISA を選択し、PC104_DPIO と DBRAM Base Address = D4000 を選択し、Interrupt Vector を IRQ5 に変

更して、［OK］をクリックします。これで、この Profibus Master が右側の画面に追加されます。 
6. 右側の画面に追加された Profibus Master をダブル・クリックして、パラメータを設定します。Profi Master Address を

000 に設定します。これは、Atlas の PC/104 Profibus Board です。 
 • 外部モジュールはコミュニケイタ・アダプタと呼ばれ、左下の画面に表示されます。Equipment Available のディレクト

リの中で、これから使用するインタフェース・モジュールを選択してください。右クリックすれば Modules Configuration
の欄に挿入されます。 

7. 左側のインタフェース・モジュールの欄から右側の Modules Configuration へ、物理層に近い順番に、必要なモジュ

ールを追加します。（図6-1を参照の事。） 注： 必要なモジュールがAvailable Module[s]の欄に表示されていれば、

まず、それを追加します。 
8. Station を、その外部インタフェース・モジュールに対して設定したハードウエア・スイッチ・アドレスに合わせます。この

アドレスは、GAP の FB_EQUIP ブロックの EQUIP_NO 入力の値と一致しなければなりません。 
 • Module Configuration タブでは、モジュールの入力のバイト数と出力のバイト数を表示します。この入力のバイト数と

出力のバイト数は、GAP のアプリケーション・ソフトウエアを作成する時に必要になりますから、記録しておいてくださ

い。 
9. File → Save を選択して、設定内容を格納します。 
10. File → List を選択して、設定内容を印刷します。受信側モジュールの設定内容が印刷された書類は、保管しておいて

ください。 
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図6-1． ApplicomIOのProfibus用設定画面 
 
 注注注：：：   
 Explorerを使用して、C:\Programs\ApplicomIO\2.1\ConfigIOディレクトリの中身を、AtlasPC制御

装置のC:\Woodward\Applicationディレクトリにコピーします。コピーするのは、ディレクトリの中身

であって、ディレクトリごとコピーしないように、注意してください。 
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 注注注：：：   
 トラブルシューティングの為に、ネットワーク設定用ＰＣブートアップ時の Applicom 基板の初期化の状

態が、上の図にあるApplicom.logファイルに記録されます。このログ・ファイルはテキスト・ファイルで

あり、Notepad で開く事ができます。設定用PC、またはネットワークで接続されており NetMeeting
を実装している PC から、Explorer を使用して、このファイルの存在を確かめる事ができます。 

 
GAP の Profibus 関連事項 
 
GAPでソフトウエアを組むに当たって良く注意しなければならない事は、１個のモジュールが、設定などで何ビット、または何

バイトを使用するかという事と、各モジュールが正しいオフセットを表すように、GAP ブロックを設定するという事です。使用す

るスレイブ・インタフェースに関する、必要な入力ビットと出力ビットを全て加算します。図6-2 を参照の事。 
 
Profibus 用の GAP の設定 
1. GAP に入り、シャーシ・ブロックの slot 6 または slot 7 をダブル・クリックして、FB_MODULE を追加します。そして、

Generate Channel Sheetを選択すると、FB_MODULEのブロックが新しいシートに追加されます。これは、ペアレン

ト・ブロックです。図2-3 の例を参照の事。 
2. FB_EQUIP ブロックを追加します。FB_MODULE の IO_B_x 入力は、FB_EQUIP ブロックから引いて来なければ

なりません。このブロックは、スレイブ機器内のモジュールの種類と数を表します。 
3. FB_AI、FB_AO、FB_BI、FB_BO などを追加します。これは、I/O モジュールです。 
 
Profibus 設定の一例におけるブロックの詳細 
• FB_MODULE: フィールド・バスに接続されている全てのスレイブ機器（内のモジュール）のペアレント・ブロック。 
• FB_EQUIP: フィールド・バスに接続されている１個のスレイブ機器（内のモジュール）のセミ・ペアレント・ブロック。 

EQUIP_NO（FB_EQUIP の入力） これは、ApplicomIO のコンフィギュレーション・ツールで設定されたインタフェー

ス・モジュールのハードウエア・スイッチと MAC ID に対応します。 
IO_B_1（FB_EQUIP の入力） フィールド・バスに接続された各I/O モジュールの名前を入力します。例えば、

FB_AI、FB_AO など。 
• FB_AI: アナログ入力。物理モジュールは、ふたつのアナログ入力チャンネルを使用しています。このブロックを開き、

RPT を選択してリピート入力を追加します。 
AI_ADD_1（FB_AI 入力） 物理モジュールは、全部で 4 つの入力バイトを使用しています。このモジュールには、2
個の入力チャンネルがあり、１個のチャンネルで 2 バイト使用します。このモジュールは、物理的に、インタフェース・モ

ジュールの直ぐ右にあります。（図6-1の右上画面を参照。）従って、チャンネル１にオフセットは必要ありません。この入

力は、ゼロに設定されます。 
AI_ADD_2（FB_AI 入力） チャンネル１が使用する入力バイト数は 2 である事を考えると、この 2 番目のチャンネル

の入力オフセットは 2 になります。 
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図6-2． GAPによるProfibus設定の一例 

 
• FB_BI: ブーリアン入力。物理モジュールでは、ブーリアン入力（ディスクリート入力）を4チャンネル使用しています。こ

のブロックを開き、RPT を選択してリピート入力を 3 個追加します。 
BI_ADD_1:（FB_BI 入力） これはブーリアン・モジュールですから、入力データはビット列になっています。（低分解

能）このモジュールの物理位置は002ですが、その前に、2チャンネルのアナログ入力モジュールと出力モジュールが

物理位置000 と 001 に装着されており、（図6-1 を参照の事。）ここで 4 バイト（32 ビット）のデータ領域が確保される事

になります。従って、ブーリアン入力の最初のチャンネルのオフセットは 32（ビット）です。2 番目のチャンネルのオフセ

ットは、32+1=33（ビット）です。 
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Profibus のトラブルシューティング 
 
Applicom の PC/104 デバイスの初期化の検証 
• AtlasPC 制御装置のデスクトップ画面にアクセスするには、NetMeeting を使用します。デスクトップ画面が表示される

と、ここでポップアップ画面が現われて、”Send Ctrl+Alt+Del”と言うメッセージが表示されます。AtlasPC のデスク

トップ画面の左上隅にある［Control］タブをクリックし、”Send Ctrl+Alt+Del”を選択します。ここで、User Name と

Password を聞いてきますので、両方共、”ServiceUser”と入力します。この時、大文字、小文字の区別に注意する事。 
• Explorerを使用してC:\Woodward\Applicationに降りて行き、ApplicomIO.logファイルを開いて、そのファイルの1

番下までスクロールして、タイム・スタンプの日時が最新のログを見ます。これを見ると、初期化が成功したか、失敗した

かがわかります。初期化が正常に行われておらず、ログ・ファイルに”Impossible to access driver”と書かれて

いれば、IRQ（インタラプト要求信号）の衝突があるか、基板が正常に動作していないかの、どちらかです。 
 
Applicom のドライバ・チェック 
AtlasPC に搭載されている Applicom ドライバが起動されたかどうか確かめるには、以下のように行います。 
• NetMeeting で Atlas 制御装置にアクセスします。 
• StartボタンからProgramにマウス・カーソルを持って行き、NT Explorerを起動して、C:\winnt\Profiles\All Users\ 

Start Menu\Programs\Administrative toolsを開き、Event Viewerのショートカットを探します。将来、同じ事を何度

も行う場合の事を考えて、このショートカットのコピーを作成し、AtlasPC のデスクトップ画面に引っ張ってきます。

Eventvwr.exe を走らせて、Source の欄が ApplicomIO になっている行を探します。そうなっている行をダブル・クリッ

クして、詳細を見ます。 
 
Applicom 装置の故障チェック 
• PC/104 基板が正常に作動しておらず、Atlas の Event viewer の記録では”ApplicomIO driver is loaded 

success”となっているならば、Watch Window か MicroPanel を使用して、FB_EQUIP ブロックの COMM_ERR
出力か、FB_AO ブロックや FB_AI ブロックの FN（Fault Number）出力を見て、GAP のオンライン・ヘルプのこのブ

ロックに関する説明に、表示されたエラー出力値に対応する値があれば、それを参照します。 
 
Profibus 基板が初期化されているが、外部のモジュールと通信していない場合 
• NetMeetingで制御装置のC:\Program files\ApplicomIO\2.1 にアクセスし、readwaitIO.exeを走らせます。そして

MAC アドレス、または装置番号（インタフェース・モジュールのハードウエア・アドレス）を入力します。equipment のボ

ックスに入り、function に readQword を選択し、マウスで［Read］をクリックします。 
• １番下に表示されているステイタスは、エラー・コードです。ApplicomIO のヘルプ・ファイルを開き、このエラー・コード

の説明を見ます。Index tabで”ApplicomIO status”と入力すると、エラー・コードの一覧表のところに飛んで行きます。 
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DeviceNet 

 
DeviceNet のネットワークの動作環境の設定は、AtlasPC 制御装置（ApplicomIO コンソール）に添付して出荷される、

ApplicomIO の CD を使用して行います。このソフトウエア・ツールで、AtlasPC 制御装置を DeviceNet のマスタ、もしくはス

レイブに設定します。マスタとして動作するには、スレイブ用の EDS ファイルをインポートしてスレイブになる装置の定義と動

作内容の設定を行った上で、各装置にネットワーク・アドレスの割り付けを行っておかなければなりません。 
 
   注注注：：：   
 EDS ファイルは、装置購入時に、装置に付いて来ます。.EDS ファイルの設定値の入力・変更を行うに

は、ApplicomIO コンソールを使用しなければなりません。制御する接続の方式、関連する入出力デ

ータのサイズ、DeviceNetに関係するパラメータの一覧表を指定する事により、接続する装置のタイプ

を決定します。 
 
• EDS ファイルは最新のものを使用しなければなりません。接続する DeviceNet 装置を製作した会社に依頼して送って

もらうか、ODVA（www.odva.org）からダウンロードしてください。 
• DeviceNet 装置に.EDS ファイルが付いて来なかった場合、ユーザが ApplicomIO に適当なコマンドを入力すれば、

ネットワークに接続された装置からの情報に基づいて、最少限の項目を設定したファイルが作成されます。この EDS フ

ァイルは、装置のライブラリに自動的に挿入されます。 
 
DeviceNet における ApplicomIO の設定の例 
 
ApplicomIOをまだCDからインストールしていない場合、この章の「ApplicomIOをCD-ROMからロードする」を参照して、

インストールしてください。 
1. C:\Program Files\ApplicomIO\2.1 のディレクトリ、または ApplicomIO Console という名前のショートカットから

Apcnfgio.exe を起動します。 
2. 設定値となる文字列を新規作成する場合、File\Configuration\Manager\New を選択します。 
 



NT RTOS ソフトウエア・ツール マニュアル JA26103 

  Woodward 58

 

 
 
3. Boards Configuration に入って、Add Board を選択します。 
4. Add New Board に降りて行き、Diagnostic and Manual Configuration を選択します。 
 

 
 
5. シングル FieldBus アプリケーションの場合、D4000 と IRQ5 と PC104_DVNIO を選択します。 
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6. Files から Preferences を開き、Expert Mode がチェックされている事を確認します。 
7. Protocol に入って、Properties を選択します。 
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8. そのネットワークに当てはまる値を、選択します。DeviceNet Timeout は、慎重に設定してください。普通この値は、パ

ケットの転送所要時間の見積りの 4 倍を設定します。 
9. ネットワーク内の全てのノードを、Equipment Library から DeviceNet Master にドラッグ・アンド・ドロップ操作で移動

させます。 
 

 
 
10. 各ノードに対して、他とは異なる MACID を選択します。 
11. Little Endian か Big Endian かの、どちらかを選択します。 
12. 設定しようとするノードが Equipment Library の中に無かった場合、Library → Add で追加する事ができます。 
 

 
 
13. ノードを製作した会社が供給する EDS ファイルを選択します。 
14. 全てのノードに対して必要な設定をし終わったなら、File → Save を選択してください。 
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• C:\Program\ApplicomIO\2.1\ConfigIO ディレクトリの中身を Atlas 制御装置に転送するには、AppManager 
Transfer Application Files ボタンを使用します。Transfer File To のウインドウ画面で、Files of Type: のプル

ダウン・メニューを開き、All File(∗.∗)を選択します。Explorer.exe を使用して、ここにあるファイルを全て 
C:\ Woodward\Application のディレクトリにコピーする事もできます。 
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   注注注：：：   
 上の図にあるApplicom.logファイルには、システムのブート・アップ時のApplicom基板の初期化の

実行状況が記録されていますので、トラブルシューティングを行う時の、参考にしてください。このファイ

ルは、テキスト・ファイルであり、Notepad で開く事ができます。ネットワーク経由で制御装置に接続さ

れたPCのExplorerで見るか、NetMeetingで制御装置のExplorerを起動して、これで見る事ができ

ます。 
 
DeviceNet での GAP の設定 
 
DeviceNetの I/Oを設定した後、この I/Oの設定に基づいて、GAPでアプリケーション・ソフトウエアを作成します。AtlasPC
に DeviceNet を接続する為の設定は、以下のように行います。 
1. GAPでアプリケーション・ソフトウエアを作成する時には、スロット6やスロット７に対してFB_MODULEを指定します。

Fieldbus モジュールは、全て、同じペアレント・ブロックを使用します。 
 

 
 
2. ネットワークの全てのノードに対して、FB_EQUIP ブロックを選択し、そのペアレント・ブロックとして FB_MODULE を

指定します。FB_EQUIPブロックに対しては、各ノードのMAC IDに指定した値をEQUIP_NOに設定しなければな

りません。 
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3. ネットワーク上のノードは全て、（SPC、VPC、SWIFT などの）特殊な GAP ブロックや（FB_AI、FB_AO、FB_BI、

FB_BO などの）ジェネリック・ブロックを使用して定義します。 
 

 
 
4. GAP でアプリケーション・ソフトウエアを作成し終わると、このソフトウエアはコンパイルされて、拡張子が EXE のファイ

ルと拡張子がRTSSのファイルが作成されますので、このふたつのファイルをAppManagerを使ってAtlasPCにダウ

ンロードします。 
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• GAP で作成したアプリケーション・プログラムが AtlasPC 制御装置で立ち上がると、DeviceNet モジュールは、

DeviceNet のネットワークを自動的に初期化して、ネットワークは動作し始めます。Applicom モジュールは、順番に全

てのノードの（入出力データの読み書きのような）制御データの更新を行います。データの更新間隔は、そのノードに指

定した、スキャン・レイト（の時間）と同じです。GAPのアプリケーション・ソフトウエアは、（FB_MODULEで設定した）レ

イト・グループ（に指定した実行時間）に 1 度の割合で、（入出力データなどの）制御値を更新します。PC/104 Device- 
Net 基板が初期化されたかどうかを確認する必要がある場合、以下のトラブルシューティングの項を参照してください。 

 
 注注注：：：   
 Applicom プログラムのスキャン・レイトの開始時刻は、レイト・グループの構造とは関係が無く、ネット

ワークのノード数によって決まります。 
 
DeviceNet のトラブルシューティング 
 
PC/104 DeviceNet が初期化されたが、Com（D1）の LED と I/O Status（D2）の LED が点灯せず、外部の

DeviceNet モジュールのステイタス LED も点灯しない。 
• 受信器側のCAN LとCAN Hの間に、正しい終端抵抗が付いているかどうか、チェックします。AtlasPCのハードウエ

ア・マニュアルを参照の事。 
• モジュールの電源と、外部の 24 V 電源をチェックします。 
 
Applicom の PC/104 デバイスの初期化の検証 
• AtlasPC 制御装置のデスクトップ画面にアクセスするには、NetMeeting を使用します。デスクトップ画面が表示される

と、ここでポップアップ画面が現われて、”Send Ctrl+Alt+Del”と言うメッセージが表示されます。AtlasPC のデスク

トップ画面の左上隅にある［Control］タブをクリックし、”Send Ctrl+Alt+Del”を選択します。ここで、User Name と

Password を聞いてきますので、両方共、”ServiceUser”と入力します。この時、大文字、小文字の区別に注意する事。 
• Explorerを使用してC:\Woodward\Applicationに降りて行き、ApplicomIO.logファイルを開いて、そのファイルの1

番下までスクロールして、タイム・スタンプの日時が最新のログを見ます。これを見ると、初期化が成功したか、失敗した

かがわかります。初期化が正常に行われておらず、ログ・ファイルに”Impossible to access driver”と書かれて

いれば、IRQ（インタラプト要求信号）の衝突があるか、基板が正常に動作していないかの、どちらかです。 
 
Applicom のドライバ・チェック 
AtlasPC に搭載されている Applicom ドライバが起動されたかどうか確かめるには、以下のように行います。 
• StartボタンからProgramにマウス・カーソルを持って行き、NT Explorerを起動して、C:\winnt\Profiles\All Users\ 

Start Menu\Programs\Administrative toolsを開き、Event Viewerのショートカットを探します。将来、同じ事を何度

も行う場合の事を考えて、このショートカットのコピーを作成し、AtlasPC のデスクトップ画面に引っ張ってきます。

Eventvwr.exe を走らせて、Source の欄が ApplicomIO になっている行を探します。そうなっている行をダブル・クリッ

クして、詳細を見ます。 
 
Watch Window を使用して Applicom 装置の故障チェックを行う 
• PC/104 基板が正常に作動しておらず、Atlas の Event viewer の記録では”ApplicomIO driver is loaded 

success”となっているならば、Watch Window か MicroPanel を使用して、FB_EQUIP ブロックの COMM_ERR
出力か、FB_AOブロックかFB_AIブロックのFN（Fault Number）出力を見て、GAPのオンライン・ヘルプのこのブロ

ックに関する説明に、表示されたエラー出力値に対応する値があれば、それを参照します。 
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DeviceNet 基板が初期化されているが、外部のモジュールと通信していない場合 
• NetMeetingで制御装置のC:\Program files\ApplicomIO\2.1 にアクセスし、readwaitIO.exeを走らせます。そして

MAC アドレス、または装置番号（インタフェース・モジュールのハードウエア・アドレス）を入力します。equipment のボ

ックスに入り、function に readQword を選択し、マウスで［Read］をクリックします。 
• １番下に表示されているステイタスは、エラー・コードです。エラー・コード 79 は、メーカ名や装置のタイプや部品の種

類を表すコードとレビジョンが、Configuration ファイルや EDS の設定と一致していない事を意味しています。その他

のエラー・コードには、33 の Timeout や、36 の Device not configured があります。ApplicomIO のヘルプ・ファイル

を開き、表示されたエラー・コードの説明を見ます。Index tab で”ApplicomIO status”と入力すると、エラー・コードの

一覧表のところに飛んで行きます。 
 
DeviceNet ステイタスの LED 
 
D1 COM（チャンネルのステイタス） 
 ミドリ OK 
 アカ MAC ID が重複 
 アカの点滅 ネットワークの故障、または装置が接続されていない 
 消灯 チャンネルが通信ラインに接続されていないか、（+24Vの）電源が接続されていない 
 
D2 I/O ステイタス 
 ミドリ OK 
 消灯 チャンネル・エラー、またはスキャナが機能していない 
 点滅 少なくとも 1 個の装置でエラーが発生している 
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 メ モ  
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第 ７ 章 
インターネットとイーサネットについて 

 
 

インターネット・プロトコル 
 
インターネット・プロトコル（IP）と言うのは、ネットワーク層でのインターネットによる通信プロトコル（規約）の事です。インター

ネット・プロトコルは、TCP（Transmission Control Protocol）と UDP（User Datagram Protocol）と言う、ふたつのトランスポ

ート層の通信プロトコルを使用します。両方共、IP がサポートするネットワーク層で通信の制御を行い、ポート番号で区別され

ます。 
 

IP アドレス 
 
IPアドレスは、8ビットのセグメント4個からなる32ビットの数値であり、各セグメントの終端にピリオドが付いています。サブネ

ット・マスクは、どのビットが、ネットワーク識別子であり、どのビットがステイション識別子であるか、決定します。（2 進数の 1 は、

IPアドレスの中で、どのビットがネットワークを区別する為の識別子であるかを示し、2進数の0は、IPアドレスの中でどのビッ

トがネットワークに接続されたデバイス／コンピュータを区別する為の識別子であるかを示します。 サブネット・マスクは、例

えば、255.255.0.0 = 11111111.11111111.00000000.00000000のような値です。）IPアドレスの上位16ビットでネットワーク

を区別し、下位16 ビットでデバイスを区別します。 
 
IP ネットワークには、A、B、C の３種類のクラス（規模）があります。このクラスは、接続可能なデバイスやサブ・ネットワークの

数によって決まりますが、これは、IP アドレスの何ビットがネットワーク番号を指定する為に使用されており、何ビットがデバイ

ス番号を指定する為に使用されているかによって決まります。IP アドレスの最初の 3 ビットはネットワークを区別する為に使用

されているので、ネットワーク識別子が 192 ∼ 223 であれば、そのネットワークは、クラス C です。 
 
   注注注：：：   
 IP アドレスには、予約されている領域があります。スタティック IP アドレスを使用したい場合、ネットワー

ク管理者にお聞きください。 
 
Gateway とは、他のドメイン・ネットワーク上の宛先（となるコンピュータ）にデータを転送する、装置、またはコンピュータの事

です。ポート番号は、使用する IP アドレスを増やさずに通信する装置の数を増やす為の（LAN に接続されたコンピュータに

付ける）論理番号です。ポート番号1 ∼ 1024は、HTTPやPOPやFTPなどの通信プロトコルで通信する装置の為に予約さ

れています。ポート番号1025 ∼ 65000 は、普通のパーソナル・コンピュータや AtlasPC や MicroNet でデータの送受信を

行う為に使用する事ができます。 
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DHCP モードでのネットワークへのログ・オン 

 
（例えば、Atlas や MicroNet や PC などの）TCP/IP で通信を行っている装置がネットワークにログ・オンする時に、DHCP 
ディスカバ・メッセージを送信します。DHCP サーバは、このメッセージを受け取ると、IP アドレスとサブネット・マスク、および

そのハードウエアへのリース時間（lease time）、または、この装置の MAC アドレスと付けて、送り返します。（リース時間は、

普通 30 日です。）この装置は、受付けのメッセージを一斉送信（broadcast）し、新しいアイデンティティーを実装する事により、

TCP/IP で送受信を行う事ができるようになります。ホストは、装置がネットワーク上の何処に割り付けられているかを表すアド

レス・マップを持っており、このマップには（コンピュータ名を表す）MACアドレスと、それに対応するIPアドレスが記載されて

います。サーバはこの作業を定期的に行いますが、ネットワークに接続されたデバイスが、IP アドレスとコンピュータ名のテ

ーブルを更新して使用できるようになるまで、1 時間位かかる事もあります。 
 

GAP とイーサネット 
 
イーサネット・ポートを通じてModbusと通信を行うには、GAPのUDPブロックを使用します。UDPは、優先順位は低いが、

時間通りに送る必要のあるデータの通信に使用され、（UDP が属する）トランスポート層におけるデータ転送の確実性はあり

ません。データの転送は、小さな固定長のパケットで行います。送信側は、パケットが全て正常に受信されたと想定し、通常、

再送は行いません。しかし、MicroNetとAtlasでは、Modbusブロック（Cコード）が、マスタに対して、スレイブにデータを送

るように指示し、スレイブは、通常であれば、データを受け取るとマスタに返事を返すので、通信ループにエラーが発生する

事はありません。（invalid data や no data が発生して）スレイブがデータを受信しなかった場合、スレイブは応答しません。

マスタは、タイマが計時を完了してタイム・アウトが発生するまで待って、その後、スレイブにデータを再送します。それでも、

スレイブにマスタからの応答が返って来なかった場合、マスタはLink Errorを発生させます。一方スレイブは、一定の時間間

隔でマスタが自分にデータを送ってくるかどうか、見ています。スレイブが、（マスタからの）送信データを受け取らなかった場

合、スレイブは Link Error を発生させます。UDP のヘッダ部は、［送信元ポート、宛先ポート、ヘッダ長、チェックサム値］か

ら成っています。 
 

インターネット関連用語 
 
 IP Internet Protocol － パケット交換方式でネットワーク間の通信を制御する通信規約。 
 IP アドレス ピリオドで区切られた 4 個の 8 ビット・セグメントから成る、32 ビットの数値。 
 TCP Transmission Control Protocol － ネットワーク間の通信を制御する通信規約。トランス

ポート層の制御を支援する。 
 UDP User Datagram Protocol － IP のトランスポート層で使用する、Host-to-Host でコネク

ションレスの（送信側は受信側に対して、相手と接続されているかどうかの確認は行わず、

相手にデータが届くものと期待して、通信回線上にデータを送り出す）通信規約 
 DHCP Dynamic Host Configuration Protocol － IP アドレスの指定を自動的に行う通信規約 
 ゲイトウエイ 他所のドメイン・ネットワーク内に存在する機器やコンピュータにデータを転送する機器や

コンピュータ 
 サブネット・マスク IP アドレスのどのビットがネットワークを表すかを示す、2 進数の値。1 になっている所が、

ネットワークを指定／区別する為の領域。0 になっている所は、ネットワークに接続された

Station ID（PC や Atlas の装置番号）を表す領域。 
 ポート ネットワークに接続された通信可能な装置の数を、IP アドレスを追加せずに増やす為の、

装置の論理番号 
 MAC Media Access Control － 通信を行う装置のハードウエアに焼き込まれた 48 ビットの固

有の数値。 
 アドレス・マッピング ホストが、MAC 付きの全ての装置に一斉送信したならば、返事が返ってきた時に、各装置

の IP アドレスと MAC アドレスを関連付ける事。 
 ネットワーク層 ネットワークにおいて、互いに通信を行う物理的な通信機器の間の始点から終点までの通

信路を確立、維持、解放する機能を実現する層。交換機、転送路、端末機器の３種によって

構成される。ネットワーク層の下には、データリンク層と物理層がある。 
 トランスポート層 ネットワーク層では、パケット交換網や ISDN 回線交換網などの様々な種類のネットワーク

が存在するが、このようなネットワークの選択や制御を、この層で行う。 
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 bootP TCP/IP などのネットワーク上で、クライアントマシンがネットワークに関する設定をサーバ

から自動的に読みこむためのプロトコル。RFC 951 として規定されている。BOOTP に対

応したクライアントはホスト名やドメイン名、IP アドレス、サブネットマスク、DNS サーバなど

を自動設定してくれるので、人力で設定する手間が省ける。 
 RPC Remote Procedure Call,／遠隔手続き呼び出し：  

ネットワーク上で稼動する別のコンピュータ上のソフトウェアが提供する機能を呼び出して

実行するための技術。 
分散アプリケーションは、このリモート プロシージャ コール (RPC) を使用して、ネットワー

ク上に点在する別のコンピュータのさまざまな機能 ( サービス ) を呼び出して、全体として

協調して動作する 1 つのコンピュータ システムを形成する。 
あるいは、コンピュータのリモート管理を行うツールなどでもよく使用される、ネットワークを

介して動作するアプリケーションには欠かせない技術。 
 
 
 
 弊社のソフトウエア www.woodward.com/ic/softwareからダウンロードする事ができます。 
 Microsoft NetMeeting www.microsoft.com/netmeetingを参照の事。 
 Microsoft VisualC++ msdn.microsoft.com/visualcを参照の事。 
 Internet Explorer 5.0 www.microsoft.comを参照の事。 
 Profibus に関する情報 www.profibus.comを参照の事。 
 DeviceNet に付いて www.odva/orgを参照の事。 
 

表7-1． このマニュアルで解説したソフトウエアをダウンロードする事ができるウエッブ・サイト 
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ソフトウエア設定記録 
 

 AtlasPCの部品番号  ______________________  
 
AppManagerで検索した 
 コンピュータ名 NTA __________________  
 
 Footprint部品番号  ______________________  
 
 Footprintのレビジョン  ______________________  
 
 Service Packのバージョン  ______________________  
 
イーサネット＃１ 
 Mode Static IP or DHCP 
 
 IP Address  ________________________________  
 
 Subnet Mask  ________________________________  
 
 Default Gateway  ________________________________  
 
イーサネット＃２ 
 Mode Static IP or DHCP 
 
 IP Address  ________________________________  
 
 Subnet Mask  ________________________________  
 
 Default Gateway  ________________________________  
 
 
 Tunable .cfg File Nmame  ________________________________  .cfg 
 
 Tunable .mdb File Name  ________________________________  .mdb 
 
 Tunable .tun File Name  ________________________________  .tun 
 
 
 ApplicomIO Configuration Name  ________________________________  
 
 ServLink .net File Name  ________________________________  .net 
 
 Watch Window .wwi File Name  ________________________________  .wwi 



 

 

 

 
 このマニュアルに付いて何か御意見や御感想がございましたら 
   下記の住所宛てに、ご連絡ください。 
 〒261-7119 千葉県千葉市美浜区中瀬 2-6  
 ワールドビジネスガーデン・マリブウエスト 19F 
 日本ウッドワードガバナー株式会社 
 マニュアル係 
 TEL:043 (213) 2191  FAX:043 (213) 2199 
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